
Welcome to NoteWorthy Composer™
NoteWorthy Composer is a music composition and notation processor for Windows. It provides for the 
creation, play back, and printing of your own musical scores. It will also export your compositions to other 
MIDI applications, thus making your compositions available to a wide variety of music software on the 
market today. Additionally, NoteWorthy Composer imports and automatically notates songs contained in 
standard MIDI files, thus enabling the play back and printing of existing songs that you may have on your 
machine already.

This section introduces the application, assists in installing and setting it up, and facilitates getting 
comfortable with its capabilities. The following areas are covered in this introduction:

Getting Started:
You have just installed NoteWorthy Composer, and your not sure where to go from here? This section can
help.

Ordering Information:
If you have not licensed your copy of NoteWorthy Composer, and you want to do so, this section tells you 
how.

Command Reference:
A description of all menu commands, keyboard shortcuts, and tool bar buttons is provided in this 
reference. Select these reference sources if you want to know what something in the 
NoteWorthy Composer application does or how it works.

Common Questions:
Commonly asked questions by users of NoteWorthy Composer and our answers. Try looking here before 
asking for assistance.

Getting Support:
If you want or need support, we can help. This tells you where and how to ask for help.

Note: For assistance on using this help file, press F1 now.

A product of NoteWorthy ArtWare



Command Reference
The following are references for the various components included in the NoteWorthy Composer 
application:

Command Reference:
All of the menu commands that are available and what they do.

Keyboard Reference:
Keystrokes that will speed the score creation process.

File Tool Bar Reference:
Shows and describes tools on the file tool bar.

Note Tool Bar Reference:
Shows and describes tools on the note tool bar.

Note: For help on using help, press the F1 key now.



Credit Card Orders
You can order NoteWorthy Composer from Public (software) Library using your MasterCard, VISA, 
American Express, or Discover card by taking advantage of one of the following order methods:

By Phone Call 800-2424-PsL (800-242-4775), or call 713-524-6394

PsL operators are standing by from 7:00 am to 6:00 PM CST Monday 
through Thursday, and from 7:00 am to 12:30 PM CST on Fridays.

By FAX FAX order to 713-524-6398 (see PsL Order Form)

By E-Mail On CompuServe, E-Mail your credit card order to id 71355,470

By Mail Mail your credit card order to: (see PsL Order Form)
PsL

PO Box 35705
Houston, TX 77235-5705

USA
 
When ordering, specify program "NoteWorthy Composer", Item/Product # 11705, and have the following
information available: your credit card number, its expiration date, your name exactly as it appears on 
your credit card, and the billing address for your card.

The above numbers are for orders only.

Any questions about the status of the shipment of the order, refunds, registration options, product details, 
technical support, volume discounts, dealer pricing, site licenses, etc., must be directed to 
NoteWorthy ArtWare (see Getting     Support  ). 

To ensure that you get the latest version, PsL will notify us within 24 hours after your order, and we will 
ship the product directly to you.

If you have an AOL, CompuServe, or Prodigy account, you have the option of sending us an E-Mail with 
your name, address, and telephone number after you order with PsL. We will use this information to send 
you an E-Mail acknowledgment of your order (including your registration codes) within 3 business days 
(which allows us time to receive your order from PsL and then process it).



How to Order NoteWorthy Composer 
NoteWorthy Composer is not a free program, but rather is distributed as Shareware for purposes of 
evaluation. This gives you the opportunity to evaluate NoteWorthy Composer for up to 30 days before you
are required to purchase a license. See section NoteWorthy Composer License and Warranty for more 
information.

A license for NoteWorthy Composer can be purchased for $39 (US Dollars drawn from a US 
institution/bank or international money order) by registering the product with NoteWorthy ArtWare. Your 
registration will grant you a license to use a single copy of any version 1.XX edition of NoteWorthy 
Composer. Registration can be done in the following ways:

**Note: The following information applies to ordering only. See Getting     Support   for details on where to 
ask questions and get other support for NoteWorthy Composer.

By Check/Money Order/International Money Order: Complete the mail order form information (see Direct 
Mail Order Form) found in the file order.wri in the NoteWorthy Composer application directory. Send a 
completed mail order form along with your payment to NoteWorthy ArtWare at the following address:

NoteWorthy ArtWare
9432 Jenmar Drive
Fuquay-Varina, NC 27526-9647
USA

Using a Credit Card: NoteWorthy Composer can be ordered by phone, FAX, or mail using your 
MasterCard, VISA, American Express or Discover card. See Credit Card Orders for more information.

On CompuServe: NoteWorthy Composer can be ordered on-line using the CompuServe Software 
Registration area. Within CompuServe, simply do the following: GO SWREG, select Register 
Shareware, select a Registration ID of 3773, then select Display Selected Titles. We are automatically 
notified of your purchase, and you will receive an E-Mail acknowledgment of your order within 2 business 
days.

Once You Have Ordered:
After we receive your order, a registration receipt will be sent to your postal address. The registration 
receipt is used to activate the licensed version. See Registration     Procedures   for more details.

We will also ship a high density application diskette containing the latest Shareware version of 
NoteWorthy Composer to you. The diskette will be of the 3½" variety unless 5¼" is specifically requested.
This diskette may arrive along with your registration receipt in the same package, or in a separate mailing.
If in a separate mailing, the registration receipt letter will indicate this.

Ordering Upgrades:
If you are a registered user, you can request a diskette upgrade by sending your request to us, 
accompanied by a payment of $5 (US). The payment must follow the guidelines spelled out in the Direct 
Ordering method above (i.e. payment must be collectable in the Unites States; no foreign checks will be 
accepted). 

You can also prepay for up to 2 upgrade mailings when you order directly from us. All you need to do is 
include the extra funds in your order. The rest is handled automatically. This is most convenient if you 
register by international money order, where the transaction costs make this an efficient method for 
paying the upgrade fee.

Note to CompuServe, AOL, and Prodigy Members:
If you include your E-Mail address in your order, you will also receive your registration receipt via E-Mail 
as soon as your order has been processed. This will enable you to immediately begin using the licensed 



features of NoteWorthy Composer on your own score files, without having to wait for a receipt in the mail. 
If you order via CompuServe's SWREG area, we receive your CompuServe id automatically, so you do 
not need to take any extra steps to provide it.

Note to Internet    E-Mail Users:
We do not send registration data over the Internet. This is due to the lack of privacy for communications 
which are not encrypted. We recommend you follow this same policy when it comes to your credit card 
info; never provide it over the Internet.

If you have an E-Mail address on the Internet and you provide it with your order, then we will automatically
send you notification on the availability of new versions of NoteWorthy Composer, as they become 
available (unless you tell us not to do so). Note that this service applies to all CompuServe, AOL, and 
Prodigy members as well.



Removing NoteWorthy Composer
The application files that are installed for NoteWorthy Composer reside almost entirely under the directory
which is designated at the time of the installation. This makes the removal of the application a relatively 
simple process. It can be done as follows:

1. Close any and all NoteWorthy Composer application windows.
Windows will not allow the removal of application files that are currently in use. If you are currently 
using NoteWorthy Composer, you must exit before continuing these steps. You will also need to close
this help file or Windows will prevent you from deleting it.

2. Remove the program manager icons added when NoteWorthy Composer was set up.
This is done by selecting each icon and then pressing the Delete key. After each icon has been 
deleted, one last press of the Delete key will then cause the NoteWorthy Composer folder to be 
deleted if there is no other icons contained within it.

3. Open the File Manager included with Windows.

4. Select the NoteWorthy Composer setup directory.
During setup, a recommended directory for installation was provided. If you accepted this directory, 
then select the NWC12 directory on the C drive by clicking on it with the left mouse button. If you 
used a different directory when installing, then select that directory now.

5. Select Delete from the File menu.
This will delete all of the files in the NoteWorthy Composer application directory. Once the delete 
operation is finished, all of the disk spaced used by NoteWorthy Composer has been freed and made 
available for your use.



NoteWorthy Composer™ License and Warranty
NoteWorthy Composer Copyright © 1994,1995 by Eric Heile

All Rights Reserved

Your use of this software indicates your acceptance to the terms and conditions as defined in this license 
agreement and warranty statement. Please carefully read these terms and conditions prior to the use of 
this software. 

Unregistered Shareware Version
The license information in this section applies only to the unregistered version of NoteWorthy Composer. 
You can confirm whether a running NoteWorthy Composer application is unregistered Shareware by 
selecting the About menu item in the Help menu of NoteWorthy Composer.

Evaluation License: NoteWorthy Composer is not a free program. You are hereby granted a limited 
license to use this version of NoteWorthy Composer for up to 30 days before you are required to 
purchase a complete license (see Ordering Information). If you elect not to purchase 
NoteWorthy Composer, you must discontinue the use of it after the evaluation period expires (see 
Removing   NoteWorthy Composer  ).

Distribution License: You are hereby granted a limited license to distribute the unregistered Shareware 
version of NoteWorthy Composer provided you comply with the distribution conditions outlines in the 
VENDOR.TXT file in the NoteWorthy Composer directory.

Registered Version
As a licensed user of NoteWorthy Composer, you are entitled to install NoteWorthy Composer on one 
machine and enjoy unrestricted use of its capabilities. You may also install NoteWorthy Composer on a 
second machine provided that it will never be in simultaneous use on more than one machine. Please 
protect your registration codes, as these are intended to be used only by you.

Disclaimer of Warranty
The NoteWorthy Composer application and its accompanying support files are provided "as is" and no 
warranty of fitness for a particular use or purpose is offered. The entire and exclusive liability implied by 
this agreement shall be limited to the replacement of defective diskette(s). Liability shall not include or 
extend to any claim for or right to recover any other damages, including but not limited to loss of profit, 
data, or use of NoteWorthy Composer or other software, or special, incidental, or consequential damages 
or other similar claims, even if NoteWorthy ArtWare has been specifically advised of the possibility of such 
damages. In no event will NoteWorthy ArtWare's liability for any damages to you or any other party ever 
exceed the actual price paid for the license to use NoteWorthy Composer.

NoteWorthy ArtWare specifically disclaims all other warranties, expressed or implied, including 
but not limited to any implied warranty of merchantability or fitness for a particular purpose.



Registration Procedures
The unregistered version of NoteWorthy Composer includes a Register command in the File menu. This 
command is used after ordering a license from NoteWorthy ArtWare (see Ordering     Information  ). This 
command opens the registration dialog where the codes provided to you are used to enable the 
registered version of NoteWorthy Composer. This command is only useful after having ordered 
NoteWorthy Composer.

After ordering NoteWorthy Composer, you will receive a registration receipt that will include your name 
and a special code which represents your purchase. You will need to enter both your name and this 
special code when prompted in the registration procedure. When entering this data, it should be typed 
exactly as it appears in the registration receipt, including any punctuation or symbols. Your name is case 
sensitive, so make sure you only capitalize the letters that are capitalized on the registration receipt. Also, 
be careful about adding extra spaces where none should be. Specifically, there should not be any spaces 
in the special code provided to you. Be careful not to add any spaces when typing the code into its 
appropriate field.

Once your name and code have been entered correctly, press the OK button and you should now be 
welcomed as a registered user. If you experience any difficulties with this operation, there is help 
available. Refer to Getting Support: for more details.



Answers to Common Questions
The following are some common questions about NoteWorthy Composer. The answers can be found by 
clicking on the word Answer at the end of each question.

1. How do I make NoteWorthy Composer play on my sound card's internal synthesizer? 
Answer

2. On some songs, when I select play, I do not hear any sound, even though NoteWorthy 
Composer sequences through the score. Why is this happening? Answer

3. Why does a note sometimes keep playing through an entire song, as if it were stuck on? 
Answer

4. How do I tell the program when I am done with a line of notes? Answer

5. How do I add a repeat symbol? Answer

6. Can I use NoteWorthy Composer to create drum or other General MIDI percussion 
parts? Answer

7. Can I configure NoteWorthy Composer to play longer, more complex songs without 
getting an "overflow" condition? Answer

8. When I try to start NoteWorthy Composer, it fails and says there is a problem with 
BWCC.DLL or CTL3DV2.DLL. How can I fix this? Answer

9. Why does my printout go crazy after a couple of pages? Answer

10. Why does NoteWorthy Composer not put out as much volume as other MIDI 
programs? Answer

11. How do I remove NoteWorthy Composer from my hard drive? Answer

12. What is the diamond that appears in front of some notation expressions? Answer



Why does NoteWorthy Composer not put out as much volume as other MIDI programs?

The loudness you hear when playing back a performance is based primarily on three parameters: MIDI 
volume, MIDI note on event velocity, and the MIDI instrument patch selected. Some sound modules also 
include a master volume, which controls the relative loudness of the whole device. Given these 
parameters, the best way to answer your question is by indicating which parameters are imported and 
exported from NWC (NoteWorthy Composer): 

MIDI Volume: This is assigned in the per-staff data of a song in NWC (note that new staves, by default, 
do NOT assign a MIDI volume to a staff). This data is exported to MIDI files, but is ignored when importing
a MIDI file.

MIDI Note On Velocity: This is controlled using the Dynamics symbol in NWC (ppp to fff). The Help file 
provides a table of the velocities used for each dynamic level. This data is exported by NWC, but is 
ignored when importing a MIDI performance.

MIDI Instrument Patch: This data is assigned per staff in NWC. It can also be inserted directly into the 
notation of a staff, to affect a change of instrument in the middle of the part. This data, when present,    is 
exported to MIDI files, and can optionally be imported using the appropriate toggle in the initial import 
dialog.

If you want NWC to play back things in a loud manner, you should always set the Volume parameter in 
the staff data to a value of 127. In addition, you should use a dynamic level of "fff" at the beginning of 
each staff. Placing an accent on certain notes will also force a higher velocity when using a dynamic other
than "fff".



Why does my printout go crazy after a couple of pages?
Generally speaking, when the printout logic starts to go a little crazy, the cause is usually one or more 
staves that do not rhythmically align with each other properly. All measures in all staves should consist of 
the same number of beats.

If you are unable to detect any bar line mis-alignments in your score, then there could be a problem with 
the formatting logic in NoteWorthy Composer. In this case, we would need to review your file to isolate the
cause of the problem. If you decide this is necessary, please attach the file in an E-Mail, and indicate what
kind of printer you are using. We will then follow up within 2 business days with diagnosis.



What is the diamond that appears in front of some notation expressions?

Most notation expressions give you the option whether you want to preserve the width of the expression 
in the staff. If you specify that an item should not preserve its width, then a diamond shape will appear in 
front of the item while in the editor. This diamond does reserve space on the staff, even though the 
remainder of the expression does not reserve any width. This allows you to select the item on the staff 
while in the editor, and yet achieve high quality printouts (since the diamond is not included in printouts, 
the paper copy will look much more polished).



When I try to start NoteWorthy Composer, it fails and says there is a problem with BWCC.DLL or 
CTL3DV2.DLL. How can I fix this?
Somewhere on your machine, one or both of the following files are corrupt or missing:

BWCC.DLL Borland Custom Control Library

CTL3DV2.DLL Microsoft 3D Controls Library

The SETUP utility attempts to copy these files to your \WINDOWS\SYSTEM directory if it determines that 
they are do not exist there already, or that they exist but are outdated versions and need to be replaced.

In order to resolve, the first thing to try would be to manually copy these two files from the setup ZIP 
directly to your \WINDOWS\SYSTEM directory. If this does not work, then we recommend using File 
Manager to track down all copies of these two files on your machine. After you find them all, delete them 
and re-setup NWC (which will re-install these files properly).

CTL3DV2.DLL Problems - More Detail
If a problem persists with the CTL3DV2.DLL library, the following additional info may help:

This file is a library provided by Microsoft which is used by applications to add 3d effects to many types of 
controls. Microsoft originally provided library CTL3D.DLL for this purpose, but too many applications were 
installing this file in places where it does not belong (it belongs in the Windows directory, or the System 
directory). Microsoft then released CTL3DV2.DLL, which does the same thing as the original, but now 
MUST be included in the proper directory before it will work. The problem you are experiencing is either a 
result of some other app improperly installing this DLL on your machine, or the DLL being corrupt on your 
disk.

The NoteWorthy Composer setup routine, SETUP.EXE, should be properly installing the CTL3DV2.DLL in
the Windows System directory for you. If this failed for some reason, you should have been notified of this
event during program SETUP. In any event, you can correct the problem by manually copying the 
CTL3DV2.DLL included in the ZIP file to the \WINDOWS\SYSTEM directory. The file should also not 
appear anywhere else on your disk, or the program could still fail. You may have to do this same 
procedure for the BWCC.DLL file, as the same rules apply for it as well (except that it does not force its 
location in the Windows directories). 



Can I play longer, more complex songs without getting an "overflow" condition?

As a general rule, when you are experiencing MIDI overflows on play back, you should double the 
"Buffers" value in the Options menu (on the Tools menu). On some files, values as high as 200 (or higher)
could be required. When using a large buffer like this, play back delay can be much slower than with a 
smaller buffer size, so you may not want to keep it at this level all of the time.

The play back high-lighting can also have difficulty keeping up if there are a large number of staves in the 
active score partition. Consider splitting the score into 2 or more partitions to speed up the note highlights 
as well as the editor itself when working with large files.



How do I make NoteWorthy Composer play on my sound card's internal synthesizer?

NoteWorthy Composer can be set up to use either your MIDI port, the internal synth of your sound card, 
or both when playing back scores. The Configure command on the MIDI menu is used to select which 
drivers should be used during play back.

Selecting Specific Sound Drivers: You can select more than one driver when configuring from the MIDI 
Configure dialog box. The easiest way to hear sound from the internal synth on your SoundBlaster card is
to select the SoundBlaster internal synth driver from this dialog, and unselect any other choices. When 
play is invoked, it will send the notes to the driver selected.

Using MIDI Mapper: If you have selected the MIDI Mapper driver for play back, then the device you hear 
playing depends on how the channels are assigned within the MIDI mapper. The port and channel that 
NoteWorthy uses to play back a score is defined on a per-staff basis. You can change the channel that is 
used for a staff by using the Edit button in the Score Builder dialog. At the bottom of the Staff Specification
dialog, the box labeled Channel can be used to assign a different channel for the part. By changing the 
channel used for a staff, you can control the device used for play back of a score through the MIDI 
Mapper driver.

One of the songs included in the demo is setup for use on a system that is using a General MIDI 
configuration through the MIDI Mapper. File NOWELL.NWC has duplicate parts for several MIDI 
channels:

· The vocal is assigned to channel 2, and duplicated on channel 13
· The right hand piano is assigned to channel 3, and duplicated on channel 14
· The left hand piano is assigned to channel 4, and duplicated on channel 15

Using this song, you may be able to trigger both the MIDI port and the internal synthesis of your sound 
card at the same time. This assumes that your MIDI Mapper is configured    to send lower channels to one
device, and higher channels to the other device.



On some songs, when I select play, I do not hear any sound, even though NoteWorthy Composer 
sequences through the score. Why is this happening?

The most likely cause for some scores not producing MIDI sound is how the channels are assigned in the 
songs. MIDI divides up music events into one of 16 different channels to facilitate performances that 
require more than one instrument. Each of up to 16 channels on a device can often be mapped to 
different instruments: piano on channel 1, flute on channel 2, etc. Not all sound cards respond to event 
data on all 16 different channels. This is what often causes some parts to not be audible when played 
back. If you are using the Microsoft MIDI Mapper, it is very often set up so that an internal sound card 
uses channels 13 through 16, with the lower channels being reserved for outboard MIDI gear such as a 
synthesizer keyboard.

From within NoteWorthy Composer, you have two options to resolve this situation:

Option 1: Select the sound card driver directly
This assumes that you are currently using the MS Midi Mapper device. You want to bypass the Midi 
Mapper and select the sound card directly. Invoke the MIDI Configure command and first unselect the 
Midi Mapper. Then select the device name that represents your sound card. Select OK, and then try to 
play the songs.

Option 2: Re-channel the songs
Open up the song you wish to play. Select the Score Builder command from the Tools menu. Select each 
part, one and a time, and press the Edit button. Inside the Staff Specification dialog, change the channel 
used for the part using the channel combobox at the lower right hand side of the dialog. If the part 
currently is assigned a low channel number like 1,2,3, etc. then change it to a high channel number like 
13, 14, or 15. If it has a channel assignment of 10 then this is likely a drum track, and you should change 
its channel to 16. After you do this for all of the parts, hopefully you will now be able to hear your songs.



Why does a note sometimes keep playing all through an entire song, as if it were stuck on?

When this occurs, the quick fix is to hit the Stop button twice. The second Stop command will cause Note 
Off events to be sent for all notes on every MIDI channel for every selected device.

As for the cause, there are several possibilities:

The most likely cause for this situation is from note ties across bar lines, where both notes do not have 
the same accidental assigned to them. For example, you might be selecting to tie a note outward, and 
then changing the key signature or clef before the recipient of the note tie is encountered. This will cause 
stuck notes, as the "Note Off" pitch will not coincide with the original "Note On" pitch. For example, if you 
have a B-Flat note, including its accidental, tied outward into a bar line, then you need to make sure that 
the note on the other side of the bar line at that staff position is also a B-Flat note, either via the key 
signature or by its accidental. Any accidental that you assign to the recipient of a note tie will be 
suppressed when the note is displayed.

The second cause is mostly a consequence of internal data getting confused. NoteWorthy Composer can 
be very sophisticated in how it handles note ties: for example you can tie a note going into a special 
ending, and NoteWorthy Composer will figure out that the note should be tied to the next note in all of the 
special endings automatically. If you do not resolve the note tie on one of the special endings, then the 
tied note will be "stuck". 

It is also possible that the score needs to be audited. Sometimes, after cutting and pasting notes, or 
adding notes with the tie outward attribute set, the internal data gets out of synch with the visual score. In 
this case, one note may understand that it is tied to the next note with its pitch, but the next note does not 
yet understand that it is the recipient of a note tie. Use the Audit Staff and/or Audit Score command to 
resolve this situation.

Lastly, if you play a score which includes the Sustain Pedal markings, and Stop the play back while the 
pedal is down, the "pedal down" effect remains for that MIDI channel even after you start play back again.
This can cause stuck notes when play is selected again. If this is the cause, the easiest solution is to hit 
the Stop button twice. 



How do I tell the program when I'm done with a line of notes?

When you are in the score editor, you work with the score as one long series of measures, without regard 
to the formatting of a system on the page. When you print, NoteWorthy Composer formats the staves you 
select based on your printer and the notation font size that you select. This allows maximum flexibility in 
printing single staff systems, conductor scores, and anything in between without having to manually 
format the notation based on what you are printing.



How do I add a repeat symbol?

You can add a repeat symbol using the Insert menu. Position the insertion point where you would like the 
repeat to begin or end, and then do the following:

1. Select "Insert", then "Notation"
2. Select "Bar Line (Decorated)..."
3. In the Bar Line Specification dialog, select one of the bar line types which include the word repeat. 

For example, Master Repeat Open creates the beginning of a repeated section which may or may 
not have special endings. Select Master Repeat Close to end a repeated section.

Note: If you use Local Repeats, special endings are not used. Also, you can select the number of repeat 
iterations using the local repeat capability when you enter the closing symbol of a local repeat.

If you have more than one staff in the active partition, you will want to add the same repeat bar line type in
the same positions for each staff. This will enable proper printing and play back of the repeated sections.



Can I use NoteWorthy Composer to create drum or other General MIDI percussion parts?

Drum sounds are typically assigned to a dedicated channel on the sound card, usually channel 10 or 
channel 16 (in some devices, drum kits are assigned to an instrument patch, rather than to a dedicated 
channel). In General MIDI, different note pitches equate to different percussive sounds. You can use 
NoteWorthy Composer to trigger these sounds by placing notes at the pitches which equate to the sounds
you wish to trigger. When using NoteWorthy Composer in this way, the best way to create drum parts is to
create one or more percussion score     partitions   for entering the rhythm parts. You will then be able to use 
Local Repeats more liberally to repeat rhythms, without impacting the structure of the melodic score. You 
can very quickly switch between score partitions using the score partition selector in the file tool bar. Once
you create a drum partition, you can enter notes wherever you wish to have a drum or other percussive 
strike. 

The following list is the General MIDI standard key mappings for drums. By placing notes at the proper 
pitches, each of these sounds can be triggered within NoteWorthy Composer.

General MIDI Drum List
*Note: Key 35 = a B Natural note (use your equipment to settle on its octave)

Key Percussion Sound
35 Acoustic Bass Drum
36 Bass Drum 1 (Note = C)
37 Side Stick
38 Acoustic Snare
39 Hand Clap
40 Electric Snare
41 Low Floor Tom
42 Closed High Hat
43 High Floor Tom
44 Pedal High Hat
45 Low Tom
46 Open High Hat
47 Low-Mid Tom
48 High-Mid Tom (Note = C)
49 Crash Cymbal 1
50 High Tom
51 Ride Cymbal 1
52 Chinese Cymbal
53 Ride Bell
54 Tambourine
55 Splash Cymbal
56 Cowbell
57 Crash Cymbal 2
58 Vibraslap
59 Ride Cymbal 2
60 High Bongo (Note = C)
61 Low Bongo
62 Mute High Conga
63 Open High Conga
64 Low Conga
65 High Timbale
66 Low Timbale
67 High Agogo
68 Low Agogo



69 Cabasa
70 Maracas
71 Short Whistle
72 Long Whistle
73 Short Guiro
74 Long Guiro
75 Claves
76 High Wood Block
77 Low Wood Block
78 Mute Cuica
79 Open Cuica
80 Mute Triangle
81 Open Triangle



NoteWorthy Composer Support Services
If you have any questions regarding the use of NoteWorthy Composer, feel free to contact us at the on-
line E-Mail addresses appearing below:

Internet: NtWorthy@AOL.COM
America Online: NtWorthy

Compuserve: 73561,1021
Prodigy: KBHV62B

Alternately, if you do not have access to on-line E-Mail to one of the accounts, you may write to us at the 
following postal address:

NoteWorthy ArtWare
9432 Jenmar Drive

Fuquay-Varina, NC 27526-9647
USA

Note to registered users: For best service, be sure to indicate that you are a registered user on any 
correspondence with NoteWorthy ArtWare. Response time for E-Mail queries will typically take less than 
48 hours.

See Also

Common Questions
Getting Started



Getting Started
After installing NoteWorthy Composer on your system, you are ready to start working with music and 
playing back existing scores and MIDI files. The following topics help you to get started in this effort.

Working with Song Files:
NoteWorthy Composer comes installed with several complete score files (as well as song excerpts) which
are ready to be played back and printed. This section explains how song files are used in 
NoteWorthy Composer.

Configuring for Sound:
NoteWorthy Composer needs to be configured for sound before any scores can be played back. This 
section explains how to do this.

Creating a New Song:
Once you have successfully played back one or more of the sample songs, you are ready to create your 
own works. This section will help you get started in this process.

Working in the Score Editor:
Whether your creating a new song, or changing an existing song, this section can help explain how the 
score editor works, and how notation can best be placed into the active staff.

Notation Lookup Reference:
This section shows excerpts from songs created in NoteWorthy Composer, and provides point and click 
access to the commands used to create the various components included in them.

NoteWorthy Composer   at a Glance:  
A representation of the NoteWorthy Composer application area is available here. Assistance on any 
component of the NoteWorthy Composer application screen is only a mouse click away. This is a great 
way to introduce yourself to the NoteWorthy Composer application screen.



Working with Song Files
NoteWorthy Composer uses its own file format to load and store song information to and from files. All 
NoteWorthy Composer files are named with a file type (or dot extension) of NWC. NoteWorthy Composer 
files can be loaded using the Open command on the File menu (see Open Command). After making 
changes to an existing song file, the changes can be preserved by saving the changes to the existing file 
or to a new file. This is accomplished by using the Save command on the File menu (see 
Save     Command  ).

NoteWorthy Composer also supports the import and export of song performances stored in standard Type
1 MIDI files. This makes it possible to convert existing MIDI performances into NoteWorthy Composer 
scores, where the song can be edited and printed in standard music notation. MIDI files can be loaded in 
the same way as NoteWorthy Composer files, using the Open Command from the File menu, or by using 
the Import     Command   on the file menu. Exporting an existing NoteWorthy Composer score file is different 
from saving the file: the Export     Command   is used for this purpose.

NoteWorthy Composer fully supports the loading of compatible files by dropping them into 
NoteWorthy Composer from the File Manager (this is often referred to as Drag and Drop compatibility). 
Using this technique, a set of MIDI and NoteWorthy Composer files can be simultaneously dropped into 
NoteWorthy Composer for subsequent editing and play back. 

For even faster and convenient access to your most recent songs, NoteWorthy Composer keeps a history
of the last ten songs which have been open. These can quickly be loaded by selecting one of the ten 
songs in the song history list on the File menu (see File History).



Configuring Sound in NoteWorthy Composer
After NoteWorthy Composer is initially installed onto your hard drive, it is immediately able to open and 
print score files with no further adjustments. The scores cannot be played back, however, until 
NoteWorthy Composer is told which sound device(s) should be used. If you do not have any sound 
hardware on your computer system, NoteWorthy Composer can still be used to create, edit, print, and 
export score files, but NoteWorthy Composer will be unable to play the scores back so that you can hear 
them.

The following steps can be used to configure NoteWorthy Composer for sound, so that you can hear 
scores on play back:

Step 1 If not open already, start the NoteWorthy Composer application

Step 2 Open the menu titled MIDI and select Configure

Step 3 Select one or more of the devices shown in the list box and click OK
If there are not any devices listed in the devices list box, then you either do not have 
sound equipment on your computer or the device has not been configured within 
Windows. Refer to the documentation associated with your sound card for information on 
setting up the device in Windows.

Hint: If there are many devices listed and you are not sure which one to select, chose the
Microsoft MIDI Mapper, if it is listed. This will allow NoteWorthy Composer to play songs 
using the same configuration that Windows uses in its multi-media players.

After completing these three steps, you are ready to start hearing the scores that you open in 
NoteWorthy Composer. When you are ready to play a score, the easiest ways of doing it are either by 

pressing the F5 function key or clicking on the  play     button   in the File     Tool     Bar  .



Creating a New Song
You can start a new song of your own by selecting the New     command   on the File menu. Once executed, 
you will immediately be prompted for important information about your new song: the title, author, and 
copyright information which you wish to assign to your new score. If you are uncertain about what you 
wish to say in this box, do not worry as you can always get back to it later using the Info     command   on the 
File menu.

After you OK the authoring information, you will be presented with the Score     Builder   dialog. A score editor
window is also displayed directly behind the score builder dialog. This window contains your new song 
inside of it. You use the Score Builder dialog to add, change, and remove song components. As you make
changes which effect the visual appearance of the score, you will be able to see the changes take effect 
in the score window behind the dialog box.

When you first create a song, a single staff, or part, is included in the song by default. If your song uses 
additional parts, then you can create and add them to your song using the New button. Once you press 
the New button, a new part is added to your song, and you are presented with the Staff     Specification   
dialog. This is where you can assign a name to the staff, as well as control its size attributes and play 
back characteristics. If you move the dialog box around so that the window behind it is visible, you will be 
able to see the start of musical score being displayed in the window. As you create new staves, you will 
be able to see them show up in the editor window.

Once you have created all of the parts that belong in the song, you may want to go back and change 
some of their parameters. This is especially true for the original staff that was included when you first 
created the song, as all of its parameters were originally assigned defaults. If you want to change any 
staff in the song, simply select the part by clicking on it, and then select the Edit button. You will be 
presented with the Staff     Specification   dialog for the selected staff, thus enabling you to change its 
characteristics.

Once you are satisfied with the number of parts that you have created, press the Done button. You are 
now ready to start notating your new song.

Click here to proceed to an introduction of the notation editor.



Introduction to the Score (Notation) Editor
Once a score is created, it can be edited by selecting a score     partition   for display in the Score Editor. Only
one score partition can be edited at a time within a score. The editor displays all of the staves that are 
included in that partition, and displays the active editor staff in a different color (the default is blue). This 
blue staff is the one where editing is active when adding, selecting, changing, or removing notation items.

The editor displays all notation in a staff from left to right as one continuous stream of notes, rests, bar 
lines, and other notation data. In other words, all notation is edited along a single horizontal access. The 
scroll bars can be used to move around in the score partition. As you move rightward, you are advancing 
further into the song. Each staff is displayed vertically, representing a different instrument or part within 
the partition. The editor view displays the score partition differently than how it would look printed. The 
print logic actually formats your composition into a printable form using additional information that you 
specify.

The active staff in the editor includes a flashing cursor, which is known as the insertion point. The 
insertion point can be moved around the staff using the arrow keys on the computer keyboard, or by 
clicking the left mouse button at the desired position. This insertion point indicates where the next item 
added to the staff will be placed. In most cases, both the vertical and horizontal position of the insertion 
point is important in determining the position of the next item. In some cases, however, the vertical 
position of the insertion point is not significant. Clefs, time signatures, key signatures, and bar lines are 
examples of items that are placed at fixed vertical positions within the staff, regardless of the position of 
the insertion point.

Notation can be added at the insertion point using either the keyboard, the mouse, or both. For computer 
keyboard advocates, the Keyboard Guide provides a good reference of all functions which can be 
accomplished without the aid of a mouse. These include fast methods for adding notes (the Enter key), 
rests (the Space Bar), and bar lines (the Tab key).

If you are using the mouse for notation entry, then you will probably be using the speed menus assigned 
to the right mouse button, in conjunction with the tool buttons and menus available at the top of the 
application. You can get more information on these topics through the following:

File Tool Bar Reference
Note Tool Bar Reference
Notation Editor Context Commands (No Selection)
Notation Editor Context Commands (Selection)

Once notation has been placed in a staff, the mouse can also be used to select items and manipulate 
them. Selection can be accomplished with the mouse by clicking in a staff, and then dragging the mouse 
while holding the left button down. If you drag the mouse close to the left or right borders of the window, 
the editor will automatically scroll the score in the appropriate direction. Once you have selected the 
target notation items, the right mouse button can be used to activate the speed menu.

Click here to proceed to the Notation Lookup Reference.



Printing the Score

Once you are happy with how a song looks and sounds, or you just simply want to review the musical 
material in the song, you can selectively print the different parts of the score. The printing logic decides 
how to best format your composition based on all of the options that you specify for the print job. For 
example, all of the following influence how one or more staves are printed onto a page: the selected 
notation size, the printing device, the page size, the presence of staff names on the front of a system, and
the number of staves selected and their size. This provides a great deal of power and flexibility in printing 
your composition, without you being burdened with all of the formatting decisions while the song is being 
composed.

For more information, see File Print Command.



Score Editor Partitions

NoteWorthy Composer allows you to arrange a song into sections which will play back simultaneously. 
These sections are called Score Partitions, and are most useful in developing different elements of a song
semi-independently. For example, you can create a song with two different partitions: one partition for 
melody (which might include a vocal staff, and the left and right hands for a piano), and a separate 
partition for drums. By placing the drum and other percussive instrument staves in a separate partition, 
you can repeat rhythmic patterns more easily without impacting the structure of the melodic score. New 
partitions are automatically created by assigning a partition name to a staff when it is created, or when 
edited, using the Score Builder dialog.

You can change the current partition displayed in the editor using the partition selection box in the file tool 
bar. See Active Score Partition Tool Box for more information.



Registration Has Its Privileges
If you are using the unregistered version of NoteWorthy Composer, the following limitations exist in its 
usage:

-> You are only granted a license to use the software for 30 days, after which you must either remove 
the software from your system or purchase a license.

-> Any files you create are branded as unregistered. Unregistered files can only be saved up to 10 
times by unregistered users. After 10 saves, unregistered files can no longer be saved by 
unregistered users. This restriction no longer applies once you register.

-> Files created by registered users cannot be changed and then saved by unregistered users.

-> When you print scores that you or other unregistered users create, a message is included in the 
printout on each staff system indicating that this is an unregistered score. In addition, the author 
and copyright fields that you may have supplied are replaced by NoteWorthy Composer specific 
information.

-> The Copy (to clipboard) function in Print Preview is not available

-> Notation items cannot be pasted into a registered score file.

Once registered, these restrictions are all removed. Any files you created while unregistered can be 
opened and saved using the registered version, thus branding them as registered files.

See Also

How to Order
License Agreement



Keyboard Guide
The following are the quick key lists for use in NoteWorthy Composer. When the words Up, Down, Left, 
or Right are used in the key chart, they refer to the four arrow keys on the keyboard.

The following quick keys are always available when editing a score:

Enter Adds a note at the insertion point
Space Adds a rest at the insertion point

Ctrl+Enter Adds a chord member at the insertion point
Tab Adds a standard bar line at the insertion point

Ctrl+V Pastes the contents of the NoteWorthy Composer clipboard
Ctrl+G Moves the insertion point to a measure that you specify

F9 Audits and redraws the active score
Ctrl+F9 Audits and redraws the active staff

1 Selects a whole note for the running note duration
2 Selects a half note for the running note duration
3 Selects a quarter note for the running note duration
4 Selects a eighth note for the running note duration
5 Selects a sixteenth note for the running note duration
6 Selects a thirty-second note for the running note duration
7 Toggles the natural sign for note entry
8 Toggles the flat sign for note entry
9 Toggles the sharp sign for note entry
/ Toggles the note tie outward status for note entry

 .(period) Toggles the dotted note status for note entry
0 Clears the note accidental, tied, and dotted status parameters
+ Shifts the running note duration to next smaller duration
- Shifts the running note duration to next larger duration
< Shifts the running note duration to next larger duration
> Shifts the running note duration to next smaller duration

Ctrl+U Toggles the outbound slur note attribute
Ctrl+A Toggles the accent note attribute
Ctrl+O Toggles the staccato note attribute

Shift+Up Toggles the upward note stem attribute
Shift+Down Toggles the downward note stem attribute

Home Moves the insertion point to the beginning of the active staff
Ctrl+Home Changes the active staff to the first staff in the system

End Moves the insertion point to the end of the active staff
Ctrl+End Changes the active staff to the last staff in the system

Ctrl+Right Arrow Moves the insertion point forward to the next measure.
Ctrl+Left Arrow Moves the insertion point backward to the nearest bar line.

Shift+L/R Arrow Selects notation as the insertion point moves
Page Up Shifts the active staff upward

Page Down Shifts the active staff downward
\ (Backslash) Shifts input focus to the Notation Font Tool

The following keys are available when notation has been selected:

~ (tilde) Brings up a context menu
Ctrl+X Cuts the selection and places it in the clipboard
Ctrl C Copies the selection into the clipboard

Ctrl+Del Clears the selection



Ctrl+E Allows a single, selected item to be edited
Ctrl+B Beams the selected notes
Ctrl+T Converts the selected notes into triplets

Backspace Removes the currently selected notes
Shift+Ctrl+Down Shifts the selected notes downward on the staff

Shift+Ctrl+Up Shifts the selected notes upward on the staff

These commands do specific things when notation is not currently selected:

~ (tilde) Brings up a context menu
Ctrl+L Opens the lyric editor dialog for the active staff
Delete Deletes the notation item to the right of the insertion point

Backspace Deletes the notation item to the left of the insertion point
Ctrl+Backspace Deletes the chord member just behind the insertion point

Shift+Ctrl+Down Shifts the running note duration to next smaller duration
Shift+Ctrl+Up Shifts the running note duration to next larger duration

Other keys not related to editing notation:

F1 Shows this help file
F5 Plays the active score
F6 Stops play

Ctrl+F4 Closes the active window
Ctrl+F6 Switches to the previous score window



File Tool Bar Reference Guide
The following tool buttons appear on the file tool bar:

Opens a new song file

Saves the active window

Prints the active score

Opens the Info dialog for the active score

Audits the active score and redraws the window

Opens the Score Builder dialog for the active score

Cuts the selection and places it in the clipboard

Copies the selection into the clipboard

Pastes the contents of the NoteWorthy Composer clipboard

Plays the active score

Stops playing of the score

Cascades all open windows

Tiles all open windows

Additionally, two control boxes appear on the file tool bar which are used to change the active score 
partition in the editor and to change editor font sizes, respectively. For more info, see Active Score 
Partition Tool Box and Editor Font Size Tool Box for more information.



Note Tool Bar Reference Guide
The following tool buttons appear on the note tool bar:

Toggles the natural sign for note entry

Toggles the flat sign for note entry

Toggles the sharp sign for note entry

Selects a whole note duration for use during note entry

Selects a half note duration for use during note entry

Selects a quarter note duration for use during note entry

Selects a eighth note duration for use during note entry

Selects a sixteenth note duration for use during note entry

Selects a 32nd note duration for use during note entry

Toggles the dotted note status for note entry

Toggles the note tie outward status for note entry

Accents the selected notes

Makes the selected notes staccato

Slurs the selected notes

Beams the selected notes

Converts the selected notes into triplets

Places upward stems on new or selected notes

Places downward stems on new or selected notes

The location and orientation of this tool bar can be changed by pressing the right mouse button while the 
mouse cursor is anywhere in the tool window. A speed menu is displayed which allows you to specify 
whether the tool bat should be oriented Horizontally across the top of the application, or Vertically along 
the left side of the application (see Note Tools Speed Menu).



NoteWorthy Composer Work Space
The following is a depiction of the NoteWorthy Composer application area as it looks when a music score 
is open and maximized within the work area. Help on any area of the application is available simply by 
clicking on any item shown.



NoteWorthy Composer File Tools

This area is a collection of tools to assist in working with score files, and manipulating the characteristics 
of the editor.

For more information, see File Tool Bar Reference.



NoteWorthy Composer Note Tools

This area is a collection of tools to assist in working with notes and rests within the score editor. Most of 
the tools are functional both during note entry, and when working with previously placed notes that are 
selected.

For more information, see Note Tool Bar Reference.



NoteWorthy Composer Menu Bar

This area is where all the menu commands for NoteWorthy Composer can be found.

For more information, see the Command Reference.



NoteWorthy Composer Clock

This field usually contains the time of day clock. When a song is playing, this field changes to an elapsed 
time counter, indicating how long the song has been playing. 

This field gets covered up by context help messages when menu commands or dialogs are open.



Available Memory and Resource Space

This field indicates how much memory is available and what percentage of Window's system resources 
are still available. The two values are separated by a colon. Keep an eye on these two values during an 
edit session. When memory or available system resources gets low, you probably want to save more 
often and consider closing some applications and/or NoteWorthy Composer files.

This field gets covered up by context help messages when menu commands or dialogs are open.



Active Staff Indicator

This field tracks the active staff in the active score window. The active staff partition name followed by the 
name of the staff is included in this field. 

In addition, the size of the staff is indicated in brackets as a percentage of items used. The closer this 
percentage is to 100 percent, the more full the staff gets. When a staff reaches 100% of capacity, it is 
considered full and very few if any new items can be added into the staff.

This field gets covered up by context help messages when menu commands or dialogs are open. 

This field also is blank when there is not an active staff in the active score. For example, this occurs when
the active song is being played.



Active Editor Staff

This area contains what is considered the active staff in the NoteWorthy Composer score editor. 

A NoteWorthy Composer score window can contain multiple staves in it. When editing a song, you work 
with one staff at a time. The staff that you are working with is considered the active staff. The active staff 
is typically a different color than the inactive staves in a window. This makes it easy to distinguish which 
staff is currently active. The color of the active staff can be controlled using the Options command.

One or more items in the active staff could be selected. The selection area is displayed in inverse video 
(or reverse colors).



Inactive Editor Staff

The staff in this area is considered an inactive staff in the NoteWorthy Composer score editor. 

A NoteWorthy Composer score window can contain multiple staves in it. When editing a song, you work 
with one staff at a time. The staff that you are working with is considered the active staff. All other staves 
in the window are inactive. The active staff is typically a different color than the inactive staves in a 
window. This makes it easy to distinguish which staff is currently active. The color of inactive staves can 
be controlled using the Options command.



Active Editor Staff Selection Area

This reverse color area in the active staff is the notation selection area. All symbols contained within a 
selection area can be acted upon by many of the edit commands. For example the selected symbols can 
be cut or copied into the NoteWorthy Composer clipboard for future pasting into somewhere else in a 
score. 

Selected notes can also have some attributes modified when they are selected in this manner. For 
example, notes can be beamed together, accented, made staccato, or slurred when they are selected 
together.

See Edit Menu Commands for more details.



NoteWorthy Composer Application Title Bar

This is the application title bar. When the active score is maximized to fill the entire 
NoteWorthy Composer application area, this title bar is updated to include the filename of this active 
score. When the active score editor is not maximized, the it will also include a title bar similar to this one. 
Windows can be quickly maximized to their largest size by double clicking in this title bar with the left 
button on the mouse.



Score Editor Horizontal Scroll Bar

This scroll bar is used to control the left to right view in the active score editor. This can be used to shift 
the view of the score without changing the location of the insertion point. Clicking on the left or right arrow 
buttons shifts the score by one item in the active staff. Clicking it on the right or left of the scroll handle will
shift the score by one measure or the appropriate direction. Lastly, grabbing the scroll handle (by pressing
and holding the left mouse button while on top of the handle) facilitates moving significant distances to 
other parts of the score.



Score Editor Vertical Scroll Bar

This scroll bar is used to control the vertical position of the score editor partition. If there are more staves 
in the edit window than can be displayed, this scroll bar will appear and make it possible to shift the view 
of the score up or down to other staves. The identity of the active staff and the location of the insertion 
point are not impacted by scrolling with this tool.



Notation Lookup Reference
The following notation excerpts demonstrate many of the notational capabilities available within 
NoteWorthy Composer. By clicking on items of interest, help on the commands used to create this 
notation is provided.

This first example shows the first few bars of a song which contains a grand staff for the piano, and a 
vocal part. This is a common score format for music transcripts of popular music written today:

This second excerpt shows a section of a song which is repeated, but includes special endings for each 
iteration. In this case, the second of two special endings is shown. Additionally, this excerpt shows a 
Segno flow direction marking, which is used in redirecting and repeating certain sections of a song. Notice
how the special endings, repeats, and flow directions marks are duplicated in all staves. This is necessary
for proper performance of the song during play back.



Repeat marks followed by a special ending is shown here. The repeat marks shown have been added 
using the Decorated Bar Line command from the Insert menu. They use the "Master Repeat Close" style 
from the Bar Line Specification dialog. This style will cause the play back of the score to repeat from an 
earlier "Master Repeat Open" bar line, or from the beginning of the song if this item is not found. If the 
repeat is to occur more than one time then Special Endings must be included prior to each instance of the
master repeat ending item.



MIDI event control items are designated with this circular, target-like symbol. Whenever a symbol like this 
is displayed, this indicates a MIDI event or series of events will be included in the performance play back 
at this point in the music. The event that has been inserted can be edited by double-clicking on the 
symbol. The resulting dialog that opens up will indicate what type of event it is. It could be either of the 
following types:

Multi-point Controller Adds a flexible MIDI controller that can be used to alter tempo, 
volume, and pitch bend parameters during play back.

Instrument Patch Adds a change of instrument at this point in the play back. 

You will typically be able to hear the result of the change included with this symbol when the song is 
playing back. These items are not, however, included in the printout of a score, so they will not detract 
from the overall quality of the printed notation.



This is a collection of notes, rests, chords, and standard bar lines. The notation editor allows the fastest 
entry for these items via the computer keyboard. Add notes by placing the insertion point at the 
appropriate spot and pressing Enter. Turn an existing note into a chord by adding a second note, using 
the Ctrl+Enter combination. Insert a rest by pressing the Space Bar. Finally, insert a standard bar line 
simply by pressing the Tab key.

You can select most attributes for a note prior to placing it on the staff by selecting the attribute in the note
tool bar. In the case of note beams and triplets, these attributes are added and removed to groups of 
selected notes, and cannot be selected prior to adding a note. In many situations, other attributes can 
also be added and removed to selected notes and rests.



This is a grand staff brace, which is included in a score by defining the first staff in the grand staff as the 
upper grand staff, and the second staff as the lower grand staff. You define these kind of score attributes 
within the Score Builder, available from the Tools menu.



This group of notes demonstrates a chord that contains two durations, with the smaller duration being 
beamed together with the next note. This grouping is constructed by first adding the half note chord at C 
and F (first add note C using the Insert Note command, include note F using the Insert Chord Item 
command). After selecting a sixteenth note duration for use in note entry (easiest way is by pressing the 
number 5 on the keyboard or by pressing the button in the note tool bar), add the sixteenth note to the 
chord (again using the Insert Chord Item command). NoteWorthy Composer automatically splits the chord
into the separate durations.

Now the Bb note that follows the chord can be added simply by moving the insertion point up a half step, 
and then pressing the Enter key, which activates the Insert Note command.

Lastly, select the chord and Bb note at the same time by holding down the shift key, and moving the 
insertion point leftward across the two items. They are highlighted as you move the insertion point, 
showing them to be selected. When both items are selected, the sixteenth notes can be beamed together 
by activating the Note Beam Attribute on the Edit menu.



Commands
This index lists the command menus available on the menu bar. Choose a menu to view a list of the 
specific commands on each menu.

Control Commands to control window size and location
File Open, save, and print commands
Edit Clipboard and selection commands
Insert Commands for the placement of various notation symbols 
MIDI MIDI Configure, play, stop, and export commands
Notes Running attributes used in note and rest entry
Tools Tools for working with the active staff and score
Window Tile, cascade, and other score window management commands
Help Help and version information commands

In addition, there are several speed menus that are available on a context sensitive basis from within the 
notation editor. These are accessed by the right mouse button or the tilde key on the keyboard:

Notation Editor Context Commands (No Selection)
Notation Editor Context Commands (Selection)

Lastly, a speed menu exists in the Note Tool Bar for controlling its placement (horizontally or vertically). It 
is accessed by pressing the right mouse button while the cursor is in the Note Tool Window.

Note Tools Speed Menu



Control Commands
A control menu is available for all NoteWorthy Composer editor windows, as well as the main 
NoteWorthy Composer workplace window. The control menu is traditionally located at the top left corner 
of a window. It is accessed within the NoteWorthy Composer workplace by pressing <Alt+Spacebar>.

The control menu can typically be used to perform the following operations:

Restore Restore the window to its original size
Move Move the window to some other location
Size Change the size of the window
Minimize Reduce the window to its smallest, iconified form
Maximize Enlarge the window to its maximum size
Close Close the window
Next Activate the next window
Previous Activate the previous window
Switch Task List Activate a different program

File Menu Commands
The File menu contains the necessary commands to open, save, and print NoteWorthy Composer files. 
All NoteWorthy Composer notation files use a file type extension of NTW. The naming convention is 
handled automatically by the NoteWorthy Composer file control commands. Help on the File manipulation
commands is provided below:

New Creates a new score file from scratch
Open Opens an existing score file
Save Saves the score in the active edit window
Save As Saves the score in the active window to a new file name
Save All Saves all open score files which have been changed
Close Closes the currently active score
Revert Reverts the currently active score back to the version saved on disk.
Import Imports Type 1 MIDI files
Export Exports Type 1 MIDI files
Info Specifies authoring information about the active score
Print Prints the active score
History Scores which have been recently    open
Exit Quits the NoteWorthy Composer application

Edit Menu Commands
Most commands available from the edit menu are designed to operate on the active staff of the active 
window. Many of the commands are only enabled after notation items have been selected in the active 
staff. Items can be selected by holding down the shift key while moving the insertion point with the mouse 
or arrow keys. Clicking the left mouse button and dragging the mouse also can be used to select notation 
items.

The commands available from the edit menu include:

Cut Cuts the selection to the clipboard
Copy Copies the selection to the clipboard
Paste Pastes the contents of the clipboard at insertion point
Clear Clears the selection (no effect on clipboard)
Selection Edits the current selection (opens appropriate dialog)



Beam Beams the note flags of the selected notes
Triplet Turns the selected notes into a triplet

Goto Moves insertion point to the measure you specify

Lyrics Opens the lyric editor dialog for this staff



Insert Menu Commands
This menu contains all of the symbols which can be inserted into a staff. All commands followed by three 
dots (...) utilize a dialog box to designate parameters associated with the item to be added. When a new 
symbol is added, it is placed at the insertion point in the active staff. When items are selected, symbols 
cannot be added to the active staff.

Note Adds a note
Rest Adds a rest
Chord Member Adds a note member to a chord
Bar Line Adds a standard bar line

                  Notation                    
Styled Bar Line Adds special bar lines
Clef Adds a bass or treble clef
Flow Direction Adds flow direction symbols such as To Coda
Key Signature Adds a key signature
Special Ending Adds special endings
Sustain Pedal Adds sustain pedal symbols
Time Signature Adds a time signature designation

                  Expressions                    
Dynamic Adds dynamics such as ppp or mf
Dynamic Variance Adds dynamic variance, such as crescendo
Performance Style Adds a performance style, such as Legato
Tempo Adds tempo designations
Tempo Variance Adds tempo variances, such as fermata and accel.
Text Adds a text expression of your choice

         MIDI Events           
Multi-point Controller Adds a generic MIDI controller
Instrument Patch Adds a change of instrument 

MIDI Menu Commands
This menu contains the commands needed to hear the currently active score. 

Play Plays the active score using the configured MIDI device(s)
Stop Stops play or resets all configured devices
Configure MIDI Configures the MIDI devices used in play back

Notes Menu Commands
This menu is where the running parameters associated with note entry are maintained. In order to 
expedite note, chord, and rest entry, all note parameters are controlled through this menu. Each new note
or rest that is added to the staff utilizes the parameters that are checked in this menu.

Natural Future notes will include a natural sign
Flat Future notes will include a flat sign
Sharp Future notes will include a sharp sign

Whole Checked prior to adding a whole note/rest
Half Checked prior to adding a half note/rest
Quarter Checked prior to adding a quarter note/rest
Eighth Checked prior to adding a eighth note/rest



Sixteenth Checked prior to adding a sixteenth note/rest
Thirty-second Checked prior to adding a thirty-second note/rest
Sixty-fourth Checked prior to adding a sixty-fourth note/rest

Dotted Marks subsequent notes and rests as being dotted notes
Tied Marks subsequent notes as being tied to the next note
Accent Toggles the accent attribute of the selected notes
Slur Toggles the outbound slur attribute of the selected notes
Staccato Toggles the staccato attribute of the selected notes

Stem Up Toggles the upward stem attribute 
Stem Down Toggles the downward stem attribute 

Tools Menu Commands
This menu contains tools for working with the score files, including the Score Builder and audit methods 
for individuals staves and whole scores.

Score Builder Used to new build scores, and change existing scores
View Partition Used to change the partition in the active score

Automatic Beam Automatically beaming function for the active staff
Transpose Staff Transposes the active staff up or down in semitones
Force Accidentals Forces all notes in active staff to be labeled with an accidental

Staff Audit Used to audit just the currently active staff, if it needs it
Score Audit Used to audit all of the active score
Bar Lines Audit Audits and replaces the bar line structure of the current staff
Accidentals Audit Audits and polishes the accidental assignments in the active staff

Options Configure NoteWorthy Composer application preferences

Window Menu Commands
This collection of commands enables manipulating the arrangement of editor windows in the 
NoteWorthy Composer workplace.

Cascade Cascades all open windows that are not minimized
Tile Tiles all open windows that are not minimized
Arrange Icons Arranges all minimized windows
Close All Closes all open windows
File Control Bar Toggles the display of the File Tool Bar
Note Control Bar Toggles the display of the Note/Score Tool Bar
Status Bar Toggles the display of the Status Bar
Child List Short list of open windows which can be activated
More Windows Complete list of open windows (more than 9 windows)

Help Menu Commands
The commands in this menu are dedicated to providing version/license information and convenient 
access to important components of this help file. While working in NoteWorthy Composer, you can either 
select a command from this menu when you need help or press F1 to get context sensitive help 
information based on what you are currently doing. For example, pressing F1 when an item is highlighted 
in the menu bar will take you directly to the appropriate place in this help file.



See Also

About Issues the About dialog



Editor Context Menu Commands (No Selection)
The following commands are available in the notation editor when no items are currently selected. These 
can be accessed either by: hitting the right mouse button (on a two or three button mouse), or by pressing
the "~" key on the computer keyboard.    You do not need to use the shift key for this to work. After this 
action, the appropriate notation editor context menu pops up with the choices below:

Note Adds a note
Rest Adds a rest
Chord Member Adds a note member to a chord
Bar Line Adds a standard bar line

Paste Pastes the contents of the clipboard at insertion point

                  Notation                    
Styled Bar Line Adds special bar lines
Clef Adds a bass or treble clef
Flow Direction Adds flow direction symbols such as To Coda
Key Signature Adds a key signature
Special Ending Adds special endings
Sustain Pedal Adds sustain pedal symbols
Time Signature Adds a time signature designation

                  Expressions                    
Dynamic Adds dynamics such as ppp or mf
Dynamic Variance Adds dynamic variance, such as crescendo
Performance Style Adds a performance style, such as Legato
Tempo Adds tempo designations
Tempo Variance Adds tempo variances, such as fermata and accel.
Text Adds a text expression of your choice

         MIDI Events           
Multi-point Controller Adds a generic MIDI controller
Instrument Patch Adds a change of instrument 



Editor Context Menu Commands (Selection Present)
The following commands are available in the notation editor when one or more notation items are 
currently selected in the active staff. These can be accessed either by: hitting the right mouse button (on 
a two or three button mouse), or by pressing the "~" key on the computer keyboard. You do not need to 
use the shift key for this to work. After this action, the appropriate notation editor context menu pops up 
with the choices below:

Cut Cuts the selection to the clipboard
Copy Copies the selection to the clipboard
Clear Clears the selection (no effect on clipboard)
Selection Edits the current selection (opens appropriate dialog)

Note Attributes
Beam Beams the note flags of the selected notes
Triplet Turns the selected notes into a triplet

Dotted Marks subsequent notes and rests as being dotted notes
Tied Marks subsequent notes as being tied to the next note
Accent Toggles the accent attribute of the selected notes
Staccato Toggles the staccato attribute of the selected notes
Slur Slurs the selected notes

Stem Up Toggles the upward stem attribute 
Stem Down Toggles the downward stem attribute 



Note Tools Speed Menu
The following commands are available from the Note Tool Bar speed menu:

Horizontal Positions the note tools horizontally at the top of the 
application window, under the file tools.

Vertical Positions the note tools vertically at the left side of the 
application window.

Restore Window
This restores a window to its original size and position. After a window is restored, it can be minimized or 
maximized by selecting the appropriate control menu command. When a score window is maximized, a 
restore shortcut button is available on the NoteWorthy Composer menu bar.

See Also

Control Commands
Size
Minimize
Maximize
Windows Menu Commands



Move Window
This command moves the active window around the NoteWorthy Composer workplace. When the window
is properly positioned, simply press Enter to complete the move operation. Note that this command is not 
available for a maximized window.

See Also

Control Commands
Windows Menu Commands



Size Window
This command can be used to change the size of the active window within the NoteWorthy Composer 
workplace. After selecting the size command, use the arrow keys to select the border of the window that 
will be used to adjust its size. After changing the position of the border, simply press Enter to complete the
size operation. Note that this command is not available for a window that is maximized.

See Also

Control Commands
Restore
Minimize
Maximize
Windows Menu Commands



Minimize Window 
This replaces the active window with an icon, which is a small graphic representation of the window. This 
frees up space in the application workspace for other windows to be more readily arranged and viewed. A 
shortcut button appears on the top right side of a window.

See Also

Control Commands
Restore
Size
Maximize
Windows Menu Commands



Maximize Window
This enlarges the active window to utilize as much of the screen or application workspace as is available. 
A shortcut button appears on the top right side of a window for more convenient access to this function.

See Also

Control Commands
Restore
Size
Minimize
Windows Menu Commands



Close Window 
This initiates a close operation on the active window or NoteWorthy Composer application. If any data 
contained within the window has not been saved, you will be given the opportunity to save the data prior 
to the window being closed. If a notation editor window which is currently playing is closed, the play 
operation is stopped prior to closure.

See Also

Control Commands
File Close Command
File Exit Command
Windows Menu Commands



Next Window 
This command activates the next open window within the NoteWorthy Composer application window 
chain. The order of the chain of windows is based on the order in which the windows were opened.

See Also

Control Commands
Windows Menu Commands



Previous Window 
This command activates the previous open window within the NoteWorthy Composer application window 
chain. The order of the chain of windows is based on the order in which the windows were opened.

See Also

Control Commands
Windows Menu Commands



Switch To Task
This displays all of the open applications so that you can switch to a particular task or arrange the 
applications on the screen.

See Also

Control Commands
Windows Menu Commands



New Command
This command is used to create a new NoteWorthy Composer composition. Upon receipt of a New 
request, NoteWorthy Composer puts up the file info dialog (see Info Command). You should specify the 
authoring information associated with this new song. If you chose to cancel at this point, a new file will not
be created.

Once the new song's information has been specified, a new notation editor window is created for the new 
song. Initially, only a single, unnamed staff is contained within the song, and the Score Builder is 
automatically started to build the rest of the staves in the score. After building any necessary parts, you 
can edit the new song as any other song being edited in the notation editor. The first time you chose to 
save the new file, the Save As dialog (see Save As Command) will automatically appear so that you can 
specify the file name for this new song.

See Also

File Menu Commands
Open Command
Save As Command
Info Command
Score Builder Command



Open Command 
This command opens an existing song file in a new window. This existing file is specified through the 
standard Windows file dialog.

Open File Dialog Options

File Name
Select or type the file that you wish NoteWorthy Composer to open. The selection box lists all of the files 
with the file types listed in the List Files of Type selection box. 

List Files of Type
You can specify which of the supported file types you wish to see in the file selection box. The file types 
that NoteWorthy Composer can open include:

NWC   Files  
Files created by NoteWorthy Composer itself, which always has a file extension of NWC.

Song   Files  
This lists all files that NoteWorthy Composer is capable of opening, including *.MID files (conform to the 
Standard MIDI File specification, i.e. SMF format) and *.NTW files (used by older versions of NoteWorthy 
Composer). 

SMF files are commonly used to exchange music performance data between music sequencer, notation, 
and algorithmic composition software. Any files with an extension of MID are assumed to be MIDI files 
when they are opened. For more information on importing MIDI files into NoteWorthy Composer, see 
Importing MIDI Files.

Directories
This list box provides the ability to move around the file structure on the selected drive. It is often 
convenient to store all song or NoteWorthy Composer files in their own sub-directory, or across several 
directories. 

Drives
This box provides the ability to select which disk drive contains the directory and its associated file to 
open.

See Also

File Menu Commands
Creating a New Composition
Reopening a Composition
Importing MIDI Files



Importing MIDI Files
NoteWorthy Composer can import Standard MIDI Files (SMF). This is accomplished by selecting the File 
Import command or selecting a file with a ".MID" extension from the open command (see Open 
Command). After a MIDI file has been selected in the Import File dialog, the MIDI Import Options dialog is 
opened.

The MIDI File Import Options dialog is where you can control how NoteWorthy Composer will convert the 
performance data in the MIDI file to standard music notation. The following controls are available:

Import Tempo Changes:
Tempo changes are often embedded in the MIDI file to provide rhythmic expression to the performance. 
This option enables the conversion of these tempo changes into editable notation in the 
NoteWorthy Composer score. Some performance sequences may have many tempo changes included in
the file in order to tightly control the speed of the performance, and to add expression. You may wish to 
disable the import of tempo data on these files, as it may detract from the overall visual quality of the 
imported score.

Import Sustain Pedal:
NoteWorthy Composer can convert sustain pedal events directly into standard music notation. This option
enables this conversion. In many cases, it is desirable to disable the automatic import of this data, since it
can detract from the overall visual quality of the imported score.

Import Sound Patch Changes:
NoteWorthy Composer is capable of embedding sound patch changes into the final 
NoteWorthy Composer notation data. The first sound patch encountered in a track is automatically placed
into the track data globally associated with the track performance information. Any subsequent patch 
changes found in a track can optionally be imbedded into the music notation if this option is enabled.

Automatic Beam:
When this option is enabled, NoteWorthy Composer will automatically beam any adjacent notes smaller 
than a quarter note that appear in the same beat of a measure. If you wish to do the note beaming 
manually, you can disable this option.

Detect Compound Time:
NoteWorthy Composer will automatically detect compound time signatures in a MIDI sequence when this 
option is enabled. When disabled, any time signatures encountered in the sequence are assumed to be 
simple time. This influences how the musical beat in a score is emphasized when converting note events 
into notation. For example, when this option is enabled, a sequence in 9/4 time will use a dotted half note 
as the beat when the beaming function is performed. If the option is disabled, that same sequence would 
use a quarter note as the beat when the beaming function is executed.

Smallest Note:
The smallest note value specified here influences how note events in the sequence are converted into 
music notation. Smaller note values allow more complex sequences to be notated correctly. Larger note 
values tend to simplify the resulting notation, but may not adequately represent the original musical 
sequence.

Smallest Rest:
The smallest rest option can be used to control the overall placement of rests within the score. Larger 
note values here will result in fewer rests being placed in the imported score. Smaller rests may still be 
used in order to preserve the sequence of note on events.

See Also

Open Command



Export Command



Export Command 
This command is used to export the active score to a Type 1 Standard MIDI File. This file can then be 
loaded and used by other MIDI software. The Mute field of each staff is ignored when exporting the score,
so all parts will appear in their entirety in the new MIDI file. Some components of the export can be 
controlled in order to satisfy the needs of different MIDI applications on the market. These are controlled 
with the Options command on the Tools menu (see Options Command).

When Export is first selected, the existing file name for the score is automatically changed so that the 
proper extension of .MID is used, while retaining the rest of the file name.

See Also

MIDI Menu Commands
Importing MIDI Files
Save As Command
Options Command



Save Command 
This command saves the composition in the active window to its associated file name. If the composition 
has not yet been given a name, the Save As command will automatically be invoked.

Just prior to saving the file, NoteWorthy Composer checks to see if their exists a file with the same name 
as the one about to be saved. If a file with the same name exists, it is renamed to a *.BAK file. You can 
always restore the previous version of a file after saving it by copying the *.BAK file to an *.NWC file. This 
only works for the most recent version of the file that existed prior to the last save operation.

See Also

File Menu Commands
Save As Command
Save All Command
Audit Score Command



Save As Command 
This command enables saving the currently active composition to a new file. Only the 
NoteWorthy Composer file type (*.NWC) can be saved to file in this command.

Save Song As Dialog Options

File Name
Select or type the file name that you wish to assign to this composition.

List Files of Type
Only the NWC file type can be specified from within this command. This is the only file type included in 
this list. This allows you to see the existing NoteWorthy Composer song files in the currently selected 
directory.

Directories
This list box provides the ability to move around the file structure on the selected drive. It is often 
convenient to store all song or NoteWorthy Composer files in their own sub-directory, or across several 
directories. 

Drives
This box provides the ability to select which disk drive contains the directory where you wish this new file 
to reside.

See Also

File Menu Commands
Export Command
Save Command
Save All Command



Save All Command 
When requested, NoteWorthy Composer will scan all the open songs and initiate a save operation for any
which have been changed.

See Also

File Menu Commands
Save Command
Close All Command



Revert File Command
This command reverts the active score file back to the saved version available on disk. This is a more 
convenient way of simply re-opening the file that is stored on disk while, at the same time, discarding the 
current changes made to the active score since the last save operation. Any user messages shown during
a standard open of the file are also displayed when reverting back to the saved version with this 
command.

After the Revert command has been executed, the changes that were made to the score prior to the most
recent save will be lost. For this reason, use this command with care.

See Also

File Menu Commands
Open Command
Save Command



Close File Command
This command requests closure of the currently active composition. If this composition is currently being 
played, play is stopped. The window is then closed if it has not been changed since the most recent save 
or open operation. If the file has been changed, you will be given the opportunity to save the file prior to 
its closure.

See Also

File Menu Commands
Close All Command
Control Commands



Info Command
This command provides the dialog used to define key parameters to your composition, such as its title 
and copyright information. This information is used when any parts of the score are printed. The song title 
is also used in the File History list (see History     Commands  ).

Song Title and Author Dialog Options

Song Title:
This is where you specify the title of this composition.

Author:
If this is a song of your own creation, specify your name as the author. 

Copyright Notice:
You are entitled to copyright protection for any song works that you compose. You can specify two lines of
copyright information within NoteWorthy Composer that will be displayed on the first page of the printed 
composition. A suggested phrasing is provided automatically. If you have registered, your name is also 
placed here automatically for new songs that are created.

Comments:
Any comments that you wish to make about the composition can be made here. This can be used as a 
running record of your compositional or performance process associated with the song. This information 
is not included on any printouts of the song parts.

See Also

File Menu Commands
Print Command
History Commands



Print File Command 
This command enables printing of one or more parts of the active composition. NoteWorthy Composer 
supports a variety of options when printing a score. These are specified through the Score Print dialog.

Score Print Dialog Options

Select System Staves:
NoteWorthy Composer allows you to select which staves you wish to include in the print job. All of the 
selected staves are then considered to be a single system. By default, all the staves currently in the edit 
window partition are selected for print. As staves are selected, the print metrics are updated to reflect how
much of a printed page will be used by a single system.

Single System Print Metrics:
The data displayed in this area cannot be directly changed, but is intended to provide preliminary 
feedback on how the score will look on the page prior to printing or previewing it. The System Height 
metric shows, by percentage of the total page, how large a single system will be. The Systems on a Page 
field informs you on how many systems will appear on the title page, and all subsequent pages.

Print How Much:
You may choose to print all pages in the print job, or specify a range of pages that should be printed in the
job.

Other Options:
Include Page Numbers: You can choose to include page numbers on the printed page. If you chose to 
include page numbers, you can specify what the starting page number should be. Note that 
NoteWorthy Composer never includes the page number for a page numbered as 1.

Note Size: You can control the size of the notation used in printing your score. This does not influence the
size or font used in printing the song title, author and copyright information. It does control the staff and 
notation sizes used in formatting and printing each musical system. This can be used to control how many
systems appear per page, as well as how much notation will fit into each system. It is possible to choose 
a notation size that will cause some measures of the score to run off the page. The job should be 
Previewed to ensure that this is not going to happen. The size you specify is in points, with each point 
being 1/72nd of an inch. This is the point size of the italic text used in dynamic expressions. All other 
notation will be scaled to match the italic text size.

Staff Labels: You can add the name of each staff printed to the left of the printed system from this control
box. Your choices are None (no labels are printed), First System (prints labels only on the first system of 
the title page), Top Systems (print labels on the first system of every page), and All Systems (prints 
labels on all system).

Title Page Info: When this is checked, title information is included on the first page of the score printout. 
If you are planning to use the "Copy" button in the Preview screen, you may not want to have the title 
information included in the copy.

Preview Button:
Prior to actually sending the job to the printer, you can choose to preview the print job on the screen. This 
can be used to get a general idea of how the score is being laid out by NoteWorthy Composer using the 
selected printer and notation size.

Margins Button:
You can specify custom margins for the print job from within the dialog which is accessed from this button.
Any custom margins that you specify are retained for future sessions of NoteWorthy Composer. Changing



printers does not reset any custom margins that you create.

Printer:
If you have more than one printer on your system, you can select the print destination directly from the 
print dialog box. Additionally, you can setup the selected printer using the Setup button to the right of the 
printer field. 

When you are satisfied with the print options specified, choose the Print button to begin the process of 
printing the staves. You may cancel the print job at any time prior to it completing.

See Also

File Menu Commands



Setting the Print Margins
You can control the margins used during printing using this dialog. The fields used to control the margins 
are as follows:

Top of Page: This controls the amount of space include at the top of each page of the printout.

Inside Edge: This controls the amount of space included on the inside edge each page of the 
printout. If Mirror Margins is not set, then this will always be the left side of the page.

Outside Edge: This controls the amount of space reserved for the outside edge each page of the 
printout. If Mirror Margins is not set, then this will always be the right side of the page.

Bottom of Page: This controls the amount of space include at the bottom of each page of the printout.

Mirror Margins: If you are printing on both sides of a page, you should set this field. This will force all 
pages with even numbers to be printed as if on the left side of a printed book.

If a new printer device is later selected which results in "out of range" margin setting, then the custom 
settings will be removed.

See Also

File Menu Commands
Print Command



Print Preview
This is where you can preview what the printout of your score will look like. You also can request that the 
current page be printed into a file (in bitmap format) using the Copy button.

Note: If you have a high resolution printer (360 dpi or better), the resulting bitmap from a "Copy" 
operation may be very large, and thus consume a large amount of memory. In some cases, the operation 
may fail due to insufficient memory to perform the operation.

See Also

File Menu Commands
Print Command



History Commands
The File History commands make it easier to open recent compositions within NoteWorthy Composer. 
The last ten compositions that have been worked on are stored in the file history. Access to these files is 
fast and easy through the File menu. Once selected, the file associated with the song name is 
automatically opened and available for edit and play.

The file history is updated anytime a score window is closed. The location of the songs in the history list is
only changed when a new song is added to the history. New songs are always added at position number 
1. This means that if you consistently work on the same set of ten or fewer songs, they will always appear
at the same positions in the file history.

See Also

File Menu Commands



Exit Command 
The File Exit Command closes all compositions and terminates the application. If play is currently in 
progress, it will be stopped prior to closure.

See Also

File Menu Commands



Cut Command
The cut command removes the selected items from the active staff and places them into the 
NoteWorthy Composer clipboard. The items are then available to the paste command.

See Also

Edit Menu Commands



Copy Command
This command makes a copy of the selected notes and places them in the clipboard for future paste 
operations.

See Also

Edit Menu Commands



Paste Command
Takes the note data from the clipboard and inserts it into the active staff at the insertion point.

See Also

Edit Menu Commands



Clear Command
This command removes the selected notation items from the active staff. The items are destroyed after 
removal. They are not copied to the NoteWorthy Composer clipboard.

See Also

Edit Menu Commands



Edit Selection Command
This command is used to edit a selected item on a staff. This command is only active if a single element 
is selected on the staff, and that element is not a note or rest. It allows for changing any of the parameters
associated with the item using the same dialog as was used to create the item.

See Also

Edit Menu Commands
Insert Menu Commands



Beam Notes Command
This command allows a group of selected notes to be beamed across their stems. Only adjacent notes 
and chords with at least one stem flag can be grouped in this fashion. A beam cannot cross past a rest or 
bar line, or any other item that is not considered an audible note.

When a series of one or more notes is selected, the Note Beam tool and menu option will automatically 
be enabled and checked to indicate the status of the command. The command is only enabled when it is 
possible to either beam selected notes, or remove a beam on existing selected notes. The addition or 
removal of a note beam is dependent on whether the menu item is checked or not. When the menu item 
is checked (and the tool is highlighted), this indicates that the currently selected notes include a note 
beam. By invoking the command at this point, the note beam will be removed. If the command is not 
checked, but is enabled, then when invoked, a new note beam will be added to the selected notes.

When performing the operation, any pre-assigned note stem directions are ignored, and the best stem 
direction for the combination of items is chosen. The stem direction for the grouping can be changed 
afterwards by selecting the whole group and using the stem direction buttons. Note that after removal, the
stem direction for the notes will still be set, and may require you to manually reset them if you do not like 
the way they are displayed.

See Also

Edit Menu Commands



Triplet Command
This command converts a group of selected notes, chords, and rests into a triplet grouping. Any existing 
beam or triplet grouping on these notes is removed before the new triplet grouping is assigned. The 
grouping must be a valid triplet pair for the operation to succeed. When performing the operation, any pre-
assigned note stem directions are ignored, and the best stem direction for the combination of items is 
chosen. The stem direction for the grouping can be changed afterwards by selecting the whole group and 
using the stem direction buttons.

An existing triplet grouping can be removed simply by selecting one member of the triplet group and 
activating this command. The existing triplet grouping will be removed in this situation. Note that after 
removal, the stem direction for the notes will still be set, and may require you to manually reset them if 
you do not like the way they are displayed.

See Also

Edit Menu Commands



Goto Command
This command is used to move the insertion point to a specified measure. The measure you specify must 
be greater than the starting measure number associated with the score.

See Also

Edit Menu Commands
Score Builder Command



Edit Lyrics Command
Lyrics are added to a staff using this command. Each staff can be configured for up to 4 lyric lines, each 
of which will be automatically aligned to the notes in the staff. You can quickly access the lyric editor 
dialog, where lyrics are added, by pressing Ctrl+L while in the editor. The lyrics are added within the lyric 
editor dialog using 5 tabbed property sections. 

Configuring Lyrics:
The first property section, the Configuration tab, is used to define the number of lyric lines that should be
associated with the active staff. A separate tab is then available for each of the lyric lines that have been 
defined for the staff. For your convenience, you can also change the lower boundary for the active staff 
from within the lyric configure page. 

Authoring Lyrics:
The remaining property sections, Lyric 1 through Lyric 4, are used to enter the actual lyrics. The lyrics 
that you add here are not assigned to the staff until you press the OK button. This is true for all of the lyric
tabs. None of them are assigned to the staff until you exit the dialog by pressing the OK button. Note that 
the OK button can be reached by pressing the Tab    key until the button receives the input focus. The 
Enter key is used for carriage returns within each lyric edit control, so it cannot be used to close the 
dialog box while entering lyric text.

When entering lyrics, you should separate each audible syllable with one of the following separators:

a hyphen The hyphen is used to separate syllables within a word. Each syllable will
be associated with a new note on the staff. The hyphen will automatically
be centered between the syllables on the staff.

a space A space is used to separate words within a phrase.

a carriage return A carriage return is used to start a new phrase, but generally the next 
lyric line is related to the previous line, as if they are part of a single 
verse or section.

two carriage returns Two carriage returns together creates a new paragraph, section, or verse
within the current lyric. Additional carriage returns (greater than 2 in a 
row) will be ignored by NWC. They will not exist when the lyric is opened 
again for edit.

Use of these separator conventions may become more important in later upgrades that may allow "fake 
book" arrangements. 

If you want to imbed one or more spaces into a single syllable (or utterance), you can use the underscore 
character ("_") to accomplish this. Any underscores in a lyric are displayed as spaces in the score. Using 
the underscore, you can have multiple words or syllables associated with a single note event on the 
score. You can also add space onto the front or at the end of a syllable in order to even out the notation 
display in the score.

Lyric Alignment on the Staff:
When displaying lyrics, each syllable is automatically aligned to the next note in the score. The following 
rules apply to lyric association to notes in the staff:

1. Only notes that are not the beneficiary of a slur or tie will be associated with a lyric 
syllable.

2. Split stem chords will associate a lyric syllable with the chord component with the smaller 
duration. 



3. A chord which contains one or more notes that are tied to previous notes will not be 
associated with a lyric syllable.

4. Rests are ignored when formatting a lyric line.

5. Chords which include both a rest and a chord will have an associated lyric syllable. In 
other words, a chord that is comprised of a rest and a note is considered to be an audible 
utterance. If you do not wish to attribute a word or syllable to a chord like this, then insert 
an underscore separated by spaces (or hyphens) in the lyric body at the corresponding 
syllable position.

Authoring Hints:
It does not matter which order you decide to use when composing a song which includes lyrics. You can 
author the lyrics first, and then begin to place notes in the staff, or you can add the lyric lines after the 
notes have been placed. Any lyric utterance which occurs beyond the current duration of the staff is 
retained and will be displayed as soon as new notes are added to the staff.

If the lyrics are not aligning properly to tied or slurred note groupings, then hit the F9 key to initiate an 
audit of the current score (see Score Audit).This should enable the slur groups to re-synchronize and 
work correctly. 

See Also

Edit Menu Commands
Score Builder Command



Score Builder
This command brings up the Score Builder dialog box. This provides a list of all the staves in the score, 
and button methods for manipulating (or building) components of a score. If you want to add a new staff 
to the score, press the new button and define the new staff. If you want to get rid of a particular staff, just 
press the Remove button. If you wish to change a staff in the list, select it and then press the Edit button 
(or press <Alt E>). A group of staves can quickly be muted by selecting each one and pressing <Alt M>. 
The Muted field is toggled for the selected staff.

While you build the score in the builder, the score editor will update its display to reflect any changes you 
make. If you change a staff's size boundaries, this is updated in the display if that staff appears in the 
editor behind the dialog. Any changes you make in the builder are permanent, and cannot be undone 
later, so be careful. If you remove a part inadvertently, the only way to recover it is if you had previously 
saved the score which included the deleted staff.

Measure Numbers:
You also use the builder to configure the use of measure numbers within the score. Measure numbers are
enabled using the drop-down list of possible styles:

None Measure numbers are not used
Plain Each measure includes just the number above bar lines in the top staff
Circled Each number is enclosed by a circle
Boxed Each number is enclosed by a box

The "Starting At" box is used to start the numbering from a particular value, which is usually 0 or 1, but 
can be larger values if your situation requires it. NoteWorthy Composer will automatically count the 
measure numbers, and display the count as appropriate. When printing, measure numbers are displayed 
at the start of each system on the page. In the editor, numbers are displayed for all bar lines in the staff 
that constitute a new measure. In the editor, only the top-most staff in the partition will display the 
measure number. 

See Also

Tools Menu Commands
Goto Command



Active Score Partition Tool Box
This tool makes it easy to select the active score     partition   displayed in the Score Editor. If the active score
only contains one score partition, then this box ignores any attempts to open it for purposes of changing 
the partition, since this would be unnecessary.

The active partition cannot be changed while the score is being played back. Attempts to do so are 
ignored.

See Also

File Tool Bar Reference
Tools Menu Commands



View Partition
This command brings up the Score Partition dialog, where the partition of the score in the edit window can
be changed. A single list box is included in this dialog that contains all of the score partitions in the song. 
Choose the partition you wish to see in the active window, and press enter. The partition in the window 
then changes to the staves included in that score partition.

See Also

Tools Menu Commands



Audit Staff
This command is used to audit the currently active staff and redraw the screen. You can press Ctrl+F9 to 
activate this command at any time while editing a staff. This command is useful when the display has 
become confused and needs to be redrawn. This is often necessary either because of the addition or 
removal of note slurs or ties, or due to scrolling expression items which have been designated as not 
retaining their width.

See Also

Tools Menu Commands



Audit Score
This command is used to audit all of the currently active score. This audit is always run when you first 
open a file. You can press F9 to activate this command at any time while editing. This audit can be useful 
in situations where the score display has become incorrect due to clipboard activities or other such 
inserts, deletes, and edits of items which interact with each other (e.g. slurs, tempo variances, dynamic 
variances, etc.).

See Also

Tools Menu Commands



Audit Bar Lines
This command is used to audit the bar line alignment in the active staff. If the audit finds a standard bar 
line that is mis-aligned, it is removed and a new bar line is added in the proper place. 

This command may change the rhythmic structure of your song! For example, if an existing note starts 
prior to where a bar line belongs, but extends beyond where the bar line belongs, it is split so that the bar 
line can be added. If the note is a chord that includes multiple durations, the notes of the longer duration 
are lost, and the whole chord is changed to match the shorter duration during the process of splitting the 
chord.

This command will abort if it finds that a bar line is needed in the middle of a triplet grouping or a split 
duration chord. If this occurs, you can manually insert a new bar line at the point where the audit aborted, 
and then re-initiate the audit to complete the job.

Due to the potentially radical changes that this command can make on the active staff, it is recommended
that you save    the file prior to invoking the command. If the file requires saving, you will be asked about 
this automatically when you request this tool.

See Also

Tools Menu Commands



Audit Accidentals
This command can be used to remove any unnecessary accidentals assigned to notes in the active staff. 
It compares all notes with the running key signature, and if the accidental it contains matches the running 
signature, then the accidental is removed.    It will also detect if the accidental is the enharmonic version of
a note that appears in the key signature, and convert it to the note that is within the key signature. For 
example a Gb is in the staff, and the staff is in the key of G. This note could be shown as an F#, and is 
therefore changed to this kind of note and the accidental is removed.

Note that this audit does not currently support the automatic placement of hint accidentals that many 
composers use to remind the player of the implied accidental associated with a note that is in key, but had
been altered in the prior measure.

Due to the potentially radical changes that this command can make on the active staff, it is recommended
that you save    the file prior to invoking the command. If the file requires saving, you will be asked about 
this automatically when you request this tool.

See Also

Tools Menu Commands
Force Accidentals



Audit Note Stems
This command is used to audit all of the note and rest stem directions assigned in the currently active 
staff. It will remove unnecessary stem up or down attributes and recalculate stem directions for note 
beams and triplets. This command is useful after transposing a staff into another key and you want the 
stem directions to be cleaned up to reflect the note's new positions on the staff.

Due to the potentially radical changes that this command can make on the active staff, it is recommended
that you save the file prior to invoking the command. If the file requires saving, you will be asked about 
this automatically when you request this tool.

See Also

Tools Menu Commands



Automatic Beam Command
This command can be used to automatically beam a series of adjacent notes that contain stem flags and 
also fall inside of a beat. This command does not alter any notes that are already beamed, so it can be 
run several times through the course of creating a score to beam any notes that have not yet been 
handled.

Due to the potentially radical changes that this command can make on the active staff, it is recommended
that you save    the file prior to invoking the command. If the file requires saving, you will be asked about 
this automatically when you request this tool.

See Also

Tools Menu Commands



Transpose Staff Command
This command is used to transpose the current staff up or down by a number of semitones. This is most 
often used to transpose the visual score to another key which matches the natural pitch of the currently 
selected instrument for the staff.    Both notes and any standard key signatures are transposed by the 
number of semitones that you specify. 

The audible effect of the transpose can be negated so that all staves in the score sound right when 
played back. This is done using the Transposition field in the global staff parameters. You can designate 
that the staff play back transposition be updated automatically, or you can change this yourself from 
inside the Score Builder, using the Edit button.

In some chord scenarios where an interval of a minor second is used, the result of transposition may 
include some lost or inaccurate notes in the staff . In cases where this is possible, you are warned, and 
the chords which may have a problem are shown to you, one by one. The specific things to look for which
are certain to cause trouble are:

1. Intervals of a minor second where one or more of the notes in the interval are tied to 
some other note in the staff which is not a part of the same minor second interval. The 
note tie may not be correct after transposition, as they may get transposed to different 
staff positions and accidental assignments.

2. A group of 3 or more notes that are all separated by an intervals of a minor second. In 
this case, one or more of the notes may no longer exist after the transposition. 

If any of these situations apply to the staff you are transposing, you should look over the chords as they 
are shown, and then decide whether you still wish to use the auto-transpose function. If you decide to 
proceed, we strongly recommend you save the score prior to allowing the command to continue.

Due to the potentially radical changes that this command can make on the active staff, it is recommended
that you save    the file prior to invoking the command. If the file requires saving, you will be asked about 
this automatically when you request this tool.

See Also

Tools Menu Commands



Force Accidentals Command
This command runs through all of the items in the active staff and assigns accidentals to any notes that 
do not currently have them. This can be useful when used as a step in the process of changing key 
signatures within the staff. 

Due to the potentially radical changes that this command can make on the active staff, it is recommended
that you save    the file prior to invoking the command. If the file requires saving, you will be asked about 
this automatically when you request this tool.

See Also

Tools Menu Commands
Audit Accidentals



Options Command
This command enables customization of the NoteWorthy Composer workplace. Once initiated, the 
NoteWorthy Composer Preferences dialog is presented. 

NoteWorthy Composer Preferences Dialog Options

Score Editor Colors

Background: This box is used to indicate what background color will be used in the score editor. 
Changes to this box will not take effect until after you quit NoteWorthy Composer and start it again. Be 
careful not to use a color that hides active or inactive staff colors in the editor.

Play Highlight: When a score in the active window is played, NoteWorthy Composer follows the play 
back of the score and highlights the notes as they are played. The color of the highlight can be specified 
here.

Active Staff: The NoteWorthy Composer score editor allows editing of only one staff at a time. This staff 
is the active staff. The color of the active staff and its notes can be controlled through this field.

Inactive Staff: This field controlled the color of all staves that are not currently active or being edited. It is 
recommended that this color be different from the active staff color, but this is not a strict, enforced rule.

Application Options

Status Bar Shading: This checkbox is used to control the appearance of the status bar. When checked, 
the status bar uses a three dimensional look to improve its appearance. Changes to this box do not take 
effect until your next NoteWorthy Composer session.

Enable 3d Controls: This checkbox is used to control the use of the Microsoft 3D controls library, 
CTL3DV2.DLL in your Windows System directory. Changes to this box do not take effect until your next 
NoteWorthy Composer session.

Rt Mouse Sets Insertion Pt: This checkbox is used to control how a click of the right mouse button is 
treated by the staff notation editor. If you check this box, NoteWorthy Composer will re-position the 
insertion point when you click on the right mouse button. When not check, you must use the left mouse 
button to first position the insertion point, and then the right mouse button can be used to add notation 
items. Note that when notation is selected, a right mouse click never re-positions the insertion point, thus 
leaving the selection present.

Smart Insertion Point: This checkbox is used to control how the insertion point is positioned in the score 
editor. When checked, the insertion point will generally track to the right side of any notes or rests on the 
staff. When not checked, the insertion point aligns along the transparent vertical grid that aligns all notes 
and rests in the current score partition.

Persistent Dotted Note Tool: This checkbox is used to control how the dotted note tool (in the Note 
menu) behaves during note entry. When enabled, the dotted note parameter stays selected until you 
specifically turn it off. When not enabled, the dot parameter will reset after you add a note or rest to the 
staff. 

MIDI Performance Handling

Buffers: When a score is selected for play, the notation is compiled into a MIDI event list, which is stored 
in memory buffers. The number of memory buffers which is allocated for this purpose is controlled here. If 
a particular song requires more memory buffers than are currently specified here, NoteWorthy Composer 
will indicate the overflow condition at the time the score is played.



Play: This box controls where NoteWorthy Composer starts the play back of an active score. The 
following choices are available:

from beginning Play will always begin from the beginning of the score 
regardless of the location of the insertion point

from insertion point Play will begin from the note at the insertion point

from current measure Play begins from the start of the measure that contains the 
insertion point

from 1 measure back Play begins from the first previous measure to the insertion 
point

from 2 measures back Play begins from the equivalent of 2 measures behind the 
insertion point

from 3 measures back Play begins from the equivalent of 3 measures behind the 
insertion point

Export per track key and time signatures: This checkbox is used to control whether 
NoteWorthy Composer exports key and time signatures in the track or staff where they exist as well as 
the conductor track. Some applications complain if they detect signature data in a track other than the 
conductor track.

Export Song Header Info: This box is used to control whether NoteWorthy Composer includes such 
items as song title and author information in an exported MIDI file. Some commercial MIDI and notation 
applications have trouble handling this kind of information when it is present in the conductor track of a 
MIDI file. It sometimes causes the program to assume that there is not a conductor track in the file. With 
this box, you can configure this in one of three ways:

Exclude: Disables all exporting of this kind of information in a MIDI file

Track 0: Places this information in the conductor track

Track 1: Places this information in the first sequenced track after the conductor track

See Also

MIDI Menu Commands



Editor Font Size Tool Box
The notation font used in the NoteWorthy Composer score editor can be specified in this field. The size 
that you specify is the number of pixels which separate each line in the staff.

When a new font size is selected, the editor windows are automatically updated to reflect the new font 
size. 

See Also

File Tool Bar Reference



Play Command 
This command compiles the active score and begins to play it back over the selected MIDI devices. This 
command can be quickly activated using the F5 function key, or the play icon on the file tool bar.

Prior to playing the score, the notation is compiled into MIDI memory buffers. During this process, the 
compile may run out of memory. If this occurs, a message will be displayed that a data overflow was 
detected. The number of MIDI buffers can be increased through the Options command (see Options 
Command).

If play back proceeds, but no sound is heard, there may not be any MIDI devices selected, or the song 
uses device ports that do not have devices assigned. The MIDI Configure command should be used to 
select which devices will be used during play back (see Configure     MIDI     Command  ). It is also possible that
the song uses channels on the currently selected device which are ignored by the device driver. In this 
situation, the parts in the score should be re-channeled to the range which is recognized by the selected 
device.

The point where play back begins can be customized to suit your preferences. For example, you can 
chose to have play back begin from the insertion point, instead of from the beginning of the score. See 
the Options Command for more information.

See Also

Configuring for Sound:
MIDI Menu Commands
Options Command



Stop Command 
This command is used to stop or cancel a currently playing score. It can be quickly activated from the 
keyboard using the F6 key.

If a score is not currently playing, all the open MIDI device ports will be reset. This is a good way to quiet 
stuck notes if this ever happens.

See Also

MIDI Menu Commands



Configure Command 
This command is used to select the MIDI devices in the system that NoteWorthy Composer will use for its
play back (see Play Command). When activated, the Midi Configure dialog is presented. A list of all output
devices present in your system is presented. Select all of the devices that you plan to use within 
NoteWorthy Composer play back (more than one device can be selected). If you select the Microsoft Midi 
Mapper device, you may not be able to choose other devices simultaneously, since the Midi Mapper may 
have these devices included in its own configuration.

Advanced: The advanced button is used to specify timer values used when playing back a score. These 
values are configured automatically based on the performance of the host computer when the software is 
first installed. Changing the values in the Midi Advanced Configure dialog is not recommended under 
normal NoteWorthy Composer operation. The values can be updated after a CPU or other hardware 
upgrade by using the suggested values that this dialog provides.

See Also

Configuring for Sound:
MIDI Menu Commands



Natural Command 
This command toggles the running Natural accidental parameter for use during note entry. If it is selected 
when a note or chord member is added, the resulting note on the staff will included a natural sign in front 
of it. 

Accidentals can also be assigned or removed from a group of selected notes, provided that all of the 
notes in the selection consist of the same accidental, or do not have an accidental assigned. Simply 
select the group of notes that you wish to assign the accidental, and press the desired accidental button 
on the tool bar. 

See Also

Notes Menu Commands
Note Symbol Command



Flat Command 
This command toggles the running Flat accidental parameter for use during note entry. If it is selected 
when a note or chord member is added, the resulting note on the staff will included a flat sign in front of it.

Accidentals can also be assigned or removed from a group of selected notes, provided that all of the 
notes in the selection consist of the same accidental, or do not have an accidental assigned. Simply 
select the group of notes that you wish to assign the accidental, and press the desired accidental button 
on the tool bar. 

See Also

Notes Menu Commands
Note Symbol Command



Sharp Command 
This command toggles the running Sharp accidental parameter for use during note entry. If it is selected 
when a note or chord member is added, the resulting note on the staff will included a sharp sign in front of
it. 

Accidentals can also be assigned or removed from a group of selected notes, provided that all of the 
notes in the selection consist of the same accidental, or do not have an accidental assigned. Simply 
select the group of notes that you wish to assign the accidental, and press the desired accidental button 
on the tool bar. 

See Also

Notes Menu Commands
Note Symbol Command



Whole Note Command 
This command selects a whole note duration for use during note entry. If it is selected when a note, chord 
member, or rest is added, the resulting item on the staff will have a base duration equivalent to a whole 
note. 

For audible notes and chord members, this duration is the equivalent of four quarter notes. For rests, the 
duration can vary depending on whether the rest appears by itself in a measure. If a whole rest stands 
alone in a measure, the duration is based on the current time signature.

Through the course of extended staff edits involving time signature and flow control additions and 
deletions, a whole rest duration may become confused. In the event that this happens, the proper 
duration can be restored simply by saving the file, which will trigger an audit of the staff data. The Score 
Audit can also be specifically requested from the Tools menu.

See Also

Notes Menu Commands
Note Symbol Command
Rest Symbol Command
Audit Staff Command
Audit Score Command



Half Note Command 
This command selects a half note duration for use during note entry. If it is selected when a note, chord 
member, or rest is added, the resulting item on the staff will have a base duration equivalent to a half 
note. 

If a series of selected notes and rests all have the same note head duration, then this command can also 
be invoked to change their note head duration to a half note.

See Also

Notes Menu Commands
Note Symbol Command
Rest Symbol Command



Quarter Note Command 
This command selects a quarter note duration for use during note entry. If it is selected when a note, 
chord member, or rest is added, the resulting item on the staff will have a base duration equivalent to a 
quarter note. 

If a series of selected notes and rests all have the same note head duration, then this command can also 
be invoked to change their note head duration to a quarter note.

See Also

Notes Menu Commands
Note Symbol Command
Rest Symbol Command



Eighth Note Command 
This command selects an eighth note duration for use during note entry. If it is selected when a note, 
chord member, or rest is added, the resulting item on the staff will have a base duration equivalent to a 
eighth note. 

If a series of selected notes and rests all have the same note head duration, then this command can also 
be invoked to change their note head duration to an eighth note.

See Also

Notes Menu Commands
Note Symbol Command
Rest Symbol Command



Sixteenth Note Command 
This command selects a sixteenth note duration for use during note entry. If it is selected when a note, 
chord member, or rest is added, the resulting item on the staff will have a base duration equivalent to a 
sixteenth note. 

If a series of selected notes and rests all have the same note head duration, then this command can also 
be invoked to change their note head duration to a sixteenth note.

See Also

Notes Menu Commands
Note Symbol Command
Rest Symbol Command



Thirty-second Note Command 
This command selects a 32nd note duration for use during note entry. If it is selected when a note, chord 
member, or rest is added, the resulting item on the staff will have a base duration equivalent to a thirty-
second note. 

If a series of selected notes and rests all have the same note head duration, then this command can also 
be invoked to change their note head duration to a thirty-second note.

See Also

Notes Menu Commands
Note Symbol Command
Rest Symbol Command



Sixty-fourth Note Command 
This command selects a 64th note duration for use during note entry. If it is selected when a note, chord 
member, or rest is added, the resulting item on the staff will have a base duration equivalent to a sixty-
fourth note. 

This duration is only possible from the NoteWorthy Composer command menu. When this duration is 
selected, the note duration icons in the note tool bar are all in an unselected state.

If a series of selected notes and rests all have the same note head duration, then this command can also 
be invoked to change their note head duration to a sixty-fourth note.

See Also

Notes Menu Commands
Note Symbol Command
Rest Symbol Command



Tied Note Command
This command toggles the outward note tie parameter for use during note entry. When activated, notes 
entered onto the active staff will automatically be tied to the right. They will connect with the next note that
is in the same position on the staff. A clef change should not be inserted in the middle of a note tie or 
NoteWorthy Composer will associate two notes of differing pitches together, thus preventing some notes 
from playing, and others from turning off.

A    tied note can be created after a note is placed on the staff by selecting it, and then pressing the note 
tie button on the tool bar. This only works when the following conditions are satisfied:

1) One, and only one, note or chord is selected
2) The adjacent note or chord to the right includes a note at the same position on the staff

See Also

Notes Menu Commands
Note Symbol Command



Dotted Note Command
This command toggles the dotted note duration for use during note entry. If it is selected when a note, 
chord member, or rest is added, the resulting item on the staff will have the dotted variation of its base 
duration. 

A dotted duration attribute can be added or removed from a group of selected notes after they have been 
placed in the staff. This is accomplished by selecting the notes, and then pressing the Note Dotted button 
on the tool bar. The button is highlighted when the selection includes notes with dotted durations. 
Pressing the button when it is highlighted results in the existing dotted notes being converted to their un-
dotted equivalents.

See Also

Notes Menu Commands
Note Symbol Command
Rest Symbol Command



Slur Notes Command
This command toggles the outward note slur parameter for use during note entry. When activated, notes 
entered onto the active staff will automatically be slurred to the right. They will connect with the next note 
or rest that is in the same position on the staff. 

A slur attribute can be added or removed from a group of selected notes after they have been placed in 
the staff. This is accomplished by selecting the notes, and then pressing the Note Slur button on the tool 
bar. The button is highlighted when the selection includes notes with the outbound slur attribute. Pressing 
the button when it is highlighted results in the existing slurred notes having the attribute removed.

See Also

Notes Menu Commands
Edit Menu Commands



Staccato Note Command
This command toggles the staccato note attribute for use during note entry. If it is selected when a note or
chord member is added, the resulting item on the staff will be marked as staccato. 

A staccato note attribute can be added or removed from a group of selected notes after they have been 
placed in the staff. This is accomplished by selecting the notes, and then pressing the Note Staccato 
button on the tool bar. The button is highlighted when the selection includes notes with staccato attributes.
Pressing the button when it is highlighted results in the existing staccato notes being converted to their full
note equivalents (i.e. the staccato mark is removed).

See Also

Notes Menu Commands
Edit Menu Commands



Accent Note Command 
This command toggles the note accent attribute for use during note entry. If it is selected when a note or 
chord member is added, the resulting item on the staff will be marked as accented. 

A note accent attribute can be added or removed from a group of selected notes after they have been 
placed in the staff. This is accomplished by selecting the notes, and then pressing the note accent button 
on the tool bar. The button is highlighted when the selection includes notes with an accent attribute. 
Pressing the button when it is highlighted results in the existing accented notes being converted to their 
un-accented note equivalents (i.e. the accent mark is removed).

See Also

Notes Menu Commands
Edit Menu Commands



Stem Up Command 
This command toggles the note stem up attribute for use during note entry. If it is selected when a note, 
rest, or chord member is added, the resulting item on the staff will have an upward stem, if it requires a 
stem. This parameter also applies to rests and whole notes, neither of which actually demonstrate their 
note stem direction visually.

A note's stem direction can be controlled after it has been placed in the staff. This is accomplished by 
selecting the notes, and then pressing the note stem button on the tool bar. The button is highlighted 
when the entire selection contains the stem direction attribute, otherwise it is not highlighted. The stem 
direction cannot be changed for a selection which includes a multi-directional chord or chord which 
includes a rest. 

If a note does not contain a stem direction attribute, the stem direction is determined by the position of the
note on the staff. If the Audit Note Stems command is used, all stem direction attributes will be 
reconsidered based on a note's position on the staff, its presence in a beam, as well as any preceding 
multi-voice chords which appear behind it.

See Also

Notes Menu Commands
Edit Menu Commands
Audit Note Stems Command



Stem Down Command 
This command toggles the note stem down attribute for use during note entry. If it is selected when a 
note, rest, or chord member is added, the resulting item on the staff will have an downward stem, if it 
requires a stem. This parameter also applies to rests and whole notes, neither of which actually 
demonstrate their note stem direction visually.

A note's stem direction can be controlled after it has been placed in the staff. This is accomplished by 
selecting the notes, and then pressing the note stem button on the tool bar. The button is highlighted 
when the entire selection contains the stem direction attribute, otherwise it is not highlighted. The stem 
direction cannot be changed for a selection which includes a multi-directional chord or chord which 
includes a rest. 

If a note does not contain a stem direction attribute, the stem direction is determined by the position of the
note on the staff. If the Audit Note Stems command is used, all stem direction attributes will be 
reconsidered based on a note's position on the staff, its presence in a beam, as well as any preceding 
multi-voice chords which appear behind it.

See Also

Notes Menu Commands
Edit Menu Commands
Audit Note Stems Command



Note Command
This command adds an audible music note to the active staff. It places the note at the insertion point. The
current score partition is automatically reformatted to align all notes in the proper positions. This 
command can be quickly executed by pressing the <Enter> key on the computer keyboard while in the 
score editor.

See Also

Insert Menu Commands
Notes Menu Commands



Rest Command
This command adds a rest at the insertion point. New rests can be added most efficiently through use of 
the space bar on the computer keyboard.

When adding whole note rests, the duration of the rest may change as new notes, rests, or bar lines are 
added around it. NoteWorthy Composer attempts to determine if a whole rest stands alone in a measure 
so that it can assign a duration equivalent to an entire measure. This requires calculating the time 
signature associated with this measure. If you experience any difficulties in the visual duration of a 
particular whole rest, you may need to initiate an audit of this staff, or the whole score.

See Also

Insert Menu Commands
Notes Menu Commands



Chord Member Command
This command adds a note to an existing note or rest just behind the insertion point in order to form or 
add to a chord. A chord in NoteWorthy Composer is capable of supporting notes of two differing duration 
and/or differing stem directions. If the new note's stem direction and note position is consistent with the 
note, rest, or chord to the left of the insertion point, then the new note is combined with the item to the left.

The following rules apply to chords in NoteWorthy Composer:

1. A chord can only contain one note at each vertical position on the staff. This means that two notes 
with the same pitch but differing duration or stem direction cannot be added to the staff. In addition, 
two notes at the same vertical position but with differing accidentals cannot be added to the same 
chord.

2. Attempts to add a third duration type to an existing chord with two note duration types present are 
rejected.

3. A chord containing a rest is created by first placing the rest, and then adding one or more notes to 
that rest. The duration of the rest must be smaller than that of the notes that are added to it.

4. A note with its stem going downward cannot be combined with a lower note which has its stem going 
upward. The reverse is also true: a note with its stem going upward cannot be combined with a higher
note that has a downward stem.

Chord members can be added most efficiently by pressing <Ctrl Enter> from the computer keyboard. This
automatically executes the chord member command. Chord members can be removed from a chord in a 
similar fashion by pressing <Ctrl Backspace> when the insertion point is directly to the right of the note to 
be removed. When removing notes from an existing chord that includes dual stem directions, note that 
the remaining items will still have their stem direction set. This holds true even if all of the items with 
stems going in one direction have been removed.

See Also

Insert Menu Commands
Notes Menu Commands



Bar Line Command
This command adds a standard bar line at the insertion point. This command is most efficiently issued by 
pressing the <Tab> key from the computer keyboard.

Bar lines need to be added manually during note entry. They must be added to each staff individually. 
During note entry, the bar lines will at times not align with one another in different staves. After completing
a section of a song, all bar lines should line up properly. If they do not, then there are duration differences 
between common measures of the different staves of the section. If you are unable to find the differences,
then you might try playing the section back and hearing where the parts differ in their duration. 
Additionally, you may want to save the song so that NoteWorthy Composer will do an audit. This 
sometimes clears up anomalies caused by such things as whole measure rests being assigned incorrect 
duration.

See Also

Insert Menu Commands



Styled Bar Line Command
This command allows many types of bar lines to be added to the staff. This is done through the 
presentation of the Bar Line Specification dialog. The following bar line types are supported:

Single: A standard bar line (see Bar Line Symbol Command).

Double: A double bar line, which is typically used to denote a sectional change in the score.

Section Open/Close: Bar lines used to designate the beginning and end of a section of the score.

Local Repeat Open/Close: A special form of sectional repeat symbols. These allow a section to be 
repeated for a specified number of iterations without specifying special endings for each iteration. These 
loops can be nested inside a master loop which contains special endings. The special ending designation 
does not recognize the local loop iteration count. These loops will also be executed even after a D.S. or 
D.C. flow direction has been executed.

Master Repeat Open/Close: Sectional repeat symbols for repeating a section. Each repeat should 
specify a special ending prior to the closing repeat symbol (see Special     Ending     Command  ). The closing 
repeat mark is ignored after a D.S. or D.C. flow redirection has been initiated.

Note that all repeats in a score must be added to each individual staff so that play back will be compiled 
and articulated correctly. The score printout logic will automatically display the repeat symbols at the 
proper position in a score system as long as all staves in the system have been assigned the same bar 
line types.

See Also

Insert Menu Commands



Clef Symbol Command
This command enables treble, bass, alto, and tenor clef signs to be added at the insertion point. The 
visual orientation of notes and chords contained in the score is not changed in any way when adding a 
clef to the score. Key signatures, however, are changed to represent the current clef.

When adding a clef in front of a series of notes previously placed on the staff, the notes can still be moved
to reflect the clef change if it is necessary. This is accomplished by selecting the region that should be 
shifted. The notes can then be shifted by pressing <Ctrl-Shift-Up Arrow> or <Ctrl-Shift-Down Arrow> until 
the notes are placed as desired. The accidental associated with each note is not altered during this 
process. Note stem and slur directions will be automatically adjusted to reflect the shift in position.

See Also

Insert Menu Commands



Flow Direction Symbol Command
Da Capo and Dal Segno repeat expressions are placed onto the staff with this command. The symbols 
associated with each command are automatically placed in the appropriate vertical orientation.

These symbols must be added to each staff in the score partition in order to produce the desired play 
back result.

See Also

Insert Menu Commands



Key Signature Command
A new key signature can be added at the insertion point with this command. When the key signature of an
existing section is changed, the visual properties of the notes in that section are not changed in any way.

Key signatures are not automatically propagated to all of the staves in a score. Each staff must be 
assigned the appropriate key signature. 

A key signature designating the key of C is displayed as a single natural sign in the score editor. This is 
done to visually show that a key signature is present in this location. When the score is printed out, it will 
not show the natural sign.

See Also

Insert Menu Commands



Special Ending Command
This command is used to designate that the current measure should be played during specific iterations 
of a master repeat loop. Up to seven standard iterations are possible. These are labeled 1st Ending 
through 7th Ending in the Repeat Loop Ending Specification dialog. The last ending, Default D.S./D.C. 
Ending, is used after a D.S. or D.C. flow redirection has been performed. The last primary ending and the 
default ending are usually followed by a Section Close bar line to designate the end of the master repeat 
section.

Special endings should be added to all staves in a score partition so that playback is performed properly. 
The print functionality will automatically suppress the Special Endings that appear on staves other than 
the top most in a system.

See Also

Insert Menu Commands



Sustain Pedal Command
Sustain pedal control can be added at the insertion point with this command. The MIDI sustain pedal 
controller is used during play back when these symbols are encountered.

See Also

Insert Menu Commands



Time Signature Command
A time signature can be added at the insertion point using this command. The time signature is not 
enforced within the NoteWorthy Composer score editor, so bar lines can be placed at your discretion 
(although the absence of bar lines makes a printout of the score difficult or impossible to achieve). The 
time signature does influence the duration of whole rest measures that appear in the staff.

The time signature must be assigned or added manually in each staff for it to appear.

See Also

Insert Menu Commands



Insert Dynamic Command
Performance dynamics can be added at the insertion point with this command. These control the MIDI 
note on velocity and MIDI note volume with which a particular note is sounded. The symbol is placed at 
the vertical position of the staff where the insertion point is currently located.

Currently, the default MIDI velocities used by NoteWorthy Composer when interpreting score dynamics 
are as follows:

      Dynamic        
MIDI Note
      Velocity        

ppp 10
pp 30
p 45

mp 60
mf 75
f 92
ff 108
fff 127

You can override these and assign your own MIDI velocity. If you override the velocity with a zero velocity 
then the dynamic will not alter the current running MIDI velocity in the staff.

By default, a dynamic does not alter the MIDI volume of the channel being utilized to play back the current
staff. You can change this behavior by overriding the MIDI volume behavior and specifying a MIDI volume
of your choice. If you specify a override MIDI volume value of "-1" then no MIDI volume change will be 
triggered.

The changes of a dynamic can be gradually phased into a composition by using the Dynamic Variance 
item. For example, a Crescendo can be used to gradually move a performance from a pp to a ff 
performance if it is surrounded both before and after by a dynamic as described here. The crescendo will
phase in both changes in MIDI velocity as well as MIDI volume.

See Also

Insert Menu Commands
Insert Dynamic Variance Command
Insert Multi-Point Controller Command



Insert Dynamic Variance Command
Performance dynamics can be gradually altered by combining absolute dynamics with variance items. 
This command is used to create variance items. When an item of this type is encountered during MIDI 
play back, the staff is searched backward and forward for dynamic marks. If they are found on both sides 
of the variance, then the transition from the previous dynamic to the next dynamic is introduced gradually 
into the play back of the staff. This is true for both MIDI volume and MIDI note velocities. 

It should be noted that the variance does not enforce specific rules about how the transition should take 
place based on the style of the variance. For example, a Crescendo could actually be used to fade out a 
part if the dynamics were arranged in such a way as to reduce the volume of the notes that follow in the 
staff. It is up to the composer to ensure that the MIDI velocity and volume defined by the surrounding 
dynamics reflects the true nature of the dynamic variance.

The duration of the transitional dynamic variance is based on the position of the dynamic that follows the 
variance in the staff. Note that repeats and flow direction marks are ignored when determining the 
dynamic that follows the variance. If the variance does not have a dynamic on both sides of it in the staff, 
it does not alter play back dynamics in any way.

Only the Crescendo and Decrescendo styles exhibit the variance behavior described above. The 
Diminuendo, Rinforzando, and Sforzando styles are ignored during MIDI play back.

See Also

Insert Menu Commands



Performance Style Command
This command is used to insert a predefined performance expression into the staff. You can select among
many pre-existing styles, most of which are the standard Italian spellings for the styles. Currently, only two
styles alter the way the score is played back:

Legato This style causes all note events to be played to their fullest duration, as if all notes that follow
the instruction were slurred    to the following note.

Staccato This style causes all the notes that follow it to be played with a more staccato feel than 
normal.

All other styles currently use the default play back handling.

See Also

Insert Menu Commands



Tempo Command
This command inserts a tempo designation at the insertion point. The tempo is designated in units of time
base beats per minute. You control both the time base (quarter notes, eighth notes, half notes, or their 
dotted variations) and the beats per minute in that time base. This controls the speed at which a song 
plays back. The larger the tempo, the faster the song will play.

It is usually best if tempo changes are designated in only one staff of a score, thus making it easier to 
keep track of where the tempo changes occur.

You can also add an additional Italian text expression to a tempo to humanize the tempo instruction for 
the player. These expressions do not influence the tempo in any way, as the tempo designation is used 
exclusively for this purpose. You can optionally designate that neither, one, or both of the tempo markers 
be included in the printout of the staff. The actual tempo change is always indicated in the editor, 
regardless of whether it has been configured for printouts or not.

See Also

Insert Menu Commands



Tempo Variance Command
This command is used to insert a tempo variance into the score. The following variance styles are 
supported:

BreathMark The breath mark is represented graphically in the score and indicates that the 
performer should take a breath at this position. You can optionally specify a delay 
(in 16th notes) which will influence the play back of the staff. The delay should only 
be specified for one instance of the mark at any given vertical position in the song.

Fermata The fermata is similar to the breath mark in that it is represented graphically in the 
score and has a corresponding delay. The differences are in both appearance, and 
how the delay is implemented. The fermata delay is designed to influence the note 
that immediately follows the fermata (the breath mark influences the gap between 
notes).

The other marks (Accelerando, Allargando, Rallentando, Ritardando, Ritenuto, Rubato, and 
Stringendo) do not use a predefined delay. They scan on both sides of the variance event to find the 
presence of tempo marks. If they are found, then the change from one tempo to the next is introduced 
gradually at a rate determined by the distance up to the next tempo mark. If a tempo mark is not found 
either before or after the variance mark, then no change in the tempo is introduced into the play back of 
the staff/score.

Note that it is up to the composer to make sure that the tempo variance that is actually implemented 
reflects the change indicated my the text. For example, it is technically possible to create a section which 
slows down in tempo and yet is labeled as Accelerando.

See Also

Insert Menu Commands



Insert Text Command
This command is used to insert a test instruction of your choice into the staff. It does not influence play 
back of the staff in any way, but can be useful when creating a printed score for a real performer.

As with other expression marks, you can control whether the text preserves its width in the score or does 
not influence how the score is printed. You can also indicate whether the expression should use the italic 
font or the bold font.

See Also

Insert Menu Commands



Multi-point Controller Command
This command enables MIDI controller changes as well as tempo changes to be inserted into the song 

during play back. The changes can either by absolute changes, or the item can be instructed to 
gradually produce the change (Linear Sweep).

This symbol can be used for sophisticated control over the performance of the song. For example, it can 
be used to:

· fade a part in or out during a song
· gradually speed up or slow down a selection
· change the pitch of a sustained note (string bends and the like)

The symbol produced from this command can only be seen from within the score editor. The symbol 
associated with this command does not get printed. The symbol is the target symbol, used for all score 
items which are not printable and generate MIDI codes. This symbol can be double-clicked to edit the 
parameters included in the item, without having to insert a brand new item.

When this command is invoked, the MIDI Controller Specification dialog is presented. It contains the 
following information:

MIDI Controller Specification

Controller: This is where the type of controller that you want to control should be designated. You can 
chose from:

Tempo Controls the speed of the performance
Volume Controls the loudness of the performance

Stereo Pan Controls where in a stereo image the instrument will be heard
Breath Control For instruments which support it, this controls the parameter designed to 

simulate wind flow into the instrument
Pitch Bend Most useful when used to change the pitch of a sustained note

Style: You can set up to 4 control points with different values for the controller you specify. This field 
allows you to specify the algorithm that will be used to interpret the control points.

Absolute Only the specific values at specific times will be performed
Linear Sweep Changes between the control points will be changed gradually over the 

time specified

Time Offset Multiplier: The numeric values that you place into the Time Offset field for each control 
point are relative times. They are converted to absolute musical intervals by multiplying them by the time 
offset multiplier specified here.

Linear Sweep Contour: This field can be used to control how dense a series of control changes will be 
when the Linear Sweep control change style. The larger the value you use, the fewer actual control 
changes will be used during the linear control sweep. This is most useful for pitch bends, as a very large 
number of control changes are possible when sweeping the pitch over its full range, thus sometimes 
overflowing the MIDI data stream.

Control Point Settings: The lower are of the dialog is where you actually can define up to four control 
points. The first point is automatically enabled, so there is not an enabling checkbox. The other three 
points have a checkbox which you use to enable the corresponding control point.



Time Offset: The time offset for each control point gets multiplied by the Time Offset Multiplier field and 
then added to the current song position. This is how you specify when the control point should be 
initiated. Each control point's time offset is added to the previous control point's event time. This means 
that Setting 3 will always occur sometime after Setting 2, and so on. The time offsets do not change 
when particular notes are played that follow after the controller item in the staff, so one controller item can
influence a series of note events.

Controller Value: The scroll bars next to each setting control the value associated with that control point. 
The range of the control point varies with the type of controller that has been specified.

Special Note: Inserting a Multi-point Controller that contains control points that are scheduled at time 
offset well beyond the current beat can significantly add to the hesitation time between when you 
request play and actually hear the song start to play back.

See Also

Insert Menu Commands



Instrument Patch Command
A MIDI sound patch can be sent during play back by inserting this symbol at the insertion point. This 
enables a single staff to sound like several different instruments at different parts of the score. Once 
placed on the staff, it can be changed by double-clicking it with the left mouse button.

If a particular part represented by a staff is only going to play using one instrument sound, it is probably 
best to define that instrument in the staff parameters of the score. This allows a particular staff to be 
assigned an instrument without inserting this symbol into the notation. See the Score Builder     Command   
for more information.

The symbol used to represent this item in a staff is only visible when in the score editor. It will not be 
displayed when the score is printed out. The symbol is designed to look like a target, which indicates that 
double-clicking on it will result in opening it up for editing.

Sound Patch Specification Dialog Options

Send Bank Select: This check box is used to enable or disable the bank select command in the MIDI 
stream. This can be used to select a particular bank of sounds on devices which support this command.

Patch Name: This list box lists the patches that can be sent to the device port. The patch names included
in the list are determined by the Patch List Type field.

Patch List Type: This field enables you to specify what type of patch names will be presented in the 
Patch Name list box. Four patch list types come configured with NoteWorthy Composer:

Numeric, 1 Based: This puts patch numbers in the list box. The first patch is considered patch 
number one.

Numeric, 0 Based: This also puts patch numbers in the list box. The first patch is considered patch 
number zero.

General MIDI: This lists the patch names associated with a General MIDI device such as the 
Microsoft Midi Mapper.

MT-32: This lists the patch names associated with a Roland MT-32 device.

Other patch list types can be added to this list by manipulating the NTWPATCH.INI file in the 
NoteWorthy Composer application directory.

See Also

Insert Menu Commands



Cascade Windows Command
This command arranges all open edit windows which are not minimized into a cascaded stack. All of the 
score file names will be visible in the banners of each window.

See Also

Windows Menu Commands



Tile Windows Command
This command arranges all open widows on the screen such that the client area of each window is visible
in the NoteWorthy Composer workspace. This command is most effective when three or fewer edit 
windows are open.

See Also

Windows Menu Commands



Arrange Icons Command
This command arranges all minimized windows around the bottom of the NoteWorthy Composer 
workspace.

See Also

Windows Menu Commands



Close All Windows Command
This command closes all edit windows in the NoteWorthy Composer workplace. Any songs which have 
changed since their last save will prompt for permission to save the file.

See Also

Windows Menu Commands



File Tool Bar Command
This command toggles the display status of the file tool bar. When checked, this indicates that the file tool 
bar is visible and available from within the application. When not checked, this indicates that the file tool 
bar is currently not included in the application display area. 

See Also

Windows Menu Commands



Note Tool Bar Command
This command toggles the display status of the note tool bar. When checked, this indicates that the note 
tool bar is visible and available from within the application. When not checked, this indicates that the note 
tool bar is currently not included in the application display area. 

See Also

Windows Menu Commands



Status Bar Command
This command toggles the display status of the status bar at the bottom of the application. When 
checked, this indicates that the status bar is visible and available from within the application. When not 
checked, this indicates that the status bar is currently not included in the application display area. 

See Also

Windows Menu Commands



Horizontal Command
This command causes the selected tool window to be positioned horizontally in the application. The 
change is remembered between application sessions.

See Also

Windows Menu Commands



Vertical Command
This command causes the selected tool window to be positioned vertically along the left side of the 
application. The change is remembered between application sessions.

See Also

Windows Menu Commands



Child Windows List
The first nine songs that are open in the NoteWorthy Composer workplace can be activated from this list. 
Once selected from this list, that score becomes the active window in the NoteWorthy Composer 
workplace.

See Also

Windows Menu Commands



More Windows Command
When more than nine score editor windows are open in the NoteWorthy Composer workplace, this 
command menu option becomes available. This command presents a dialog where other score editor 
windows can be activated.

See Also

Windows Menu Commands



About Command
This displays a dialog box showing the current version of NoteWorthy Composer and the pertinent 
copyright statement. If this is an unregistered version of NoteWorthy Composer, this will be indicated 
here. The registered version indicates the name of the registered, licensed owner of the product.

See Also

Help Menu Commands
License Agreement



Staff Dialog
This is where a staff can be named, and it visual and performance properties can be controlled.

Staff Specification Dialog Options

Name: This is the name assigned to the active staff. All staves in a score must have a unique name. This 
is validated prior to leaving the dialog box.

Partition: A NoteWorthy Composer song can have more than one partition associated with the song. A 
typical use of the score partition would be to divide a song up into melody and rhythm sections. This list 
box is where each staff can be assigned to a particular score partition (see View Partition). Each staff can 
be included in one, and only one, score partition. Creating a new score partition is accomplished simply 
by typing in a new partition name in this box. It will then be available to subsequent staff edits. By default, 
all new staves are assigned into a Standard score partition.

Position in Score: The position of the staff can be changed through this list box. The staff will be inserted
in front of the staff listed in this box if the position is changed from the default.

Bar Line Style: The style of the staff can be assigned in this field. This allows the following styles to be 
designated for the staff:

Standard: The staff will not have a brace on the far left, and it will not connect its bar lines to adjacent 
staves.

Upper/Lower Grand Staff: Allows a pair of staves to be designated as a grand staff. Their bar lines 
will be connected, and they will be braced on the left side in each system.

Orchestral: The staff appearance will be consistent with a conductor's score. It will have its bar lines 
connected with all adjacent staves, and will have a decorative corner added if it is the first or last staff 
in the system.

Reserved Note Positions: The top and bottom positions of the staff are defined by these fields. This 
reserves a portion of space for the notation in that staff.

Muted: This allows the staff to be disabled on subsequent play backs. All notes in the staff will be ignored 
when playing the song. Tempo marks, instrument patch changes, and volume changes will still be 
included in the play back. This also does not prevent the staff from being exported into a Standard MIDI 
File.

Part Volume: This controls the initial volume at which the instrument associated with this staff will be 
heard. A value of -1 indicates that the volume currently set for this channel should not be changed. 
Volume levels range from 0 to 127, with 127 being the loudest. By default, new staff parts have an initial 
volume of 127.

Stereo Position: This controls the initial stereo position at which the instrument associated with this staff 
will be heard. A value of -1 indicates that the stereo position currently set for this channel should not be 
changed. Stereo position levels range from 0 to 127, with 64 being the center position in the stereo 
image. New staff parts are initially assigned a pan position of 64.

Transposition: The playback of the staff can be transposed using this field. This field is used when 
exporting to a MIDI file as well as with physical play back of the score.

Device: Specify which device should be used on play back of the notation in the staff. 
NoteWorthy Composer supports up to 16 devices for play back. The device cannot be changed later from 
within the notation.



Channel: This specifies which channel on the specified device should be used for play back.

Instrument: The instrument sound patch used when playing back the staff can be designated here. This 
can be changed from within notation as well (see Instrument Patch Command).

See Also

Score Builder Command
Tools Menu Commands
MIDI Menu Commands
Insert Menu Commands




